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About Platinum Paint 
Platinum Paint began in October 1986 as a way of becoming 
acquainted with the then-brand-new Apple IIGs. In 1988 it was 
released by JEM Software as MiniPaint, a $25 "color MacPaint." 
Since then, it has grown into perhaps the most powerful paint 
program for the Apple IIGs. Platinum Paint takes the best 
features of Paintworks Gold, DeluxePaint II, and even PixelPaint 
on the Macintosh II, and adds still more new features. 

You can use Platinum Paint to compose lifelike paintings, make 
signs or color illustrations, touch-up or enhance scanned images 
with the powerful brush tool, import clip art from a variety of 
sources, and even create simple animations. No matter what 
your graphic needs are, you can get the job done faster with 
Platinum Paint. 

About this Manual 
This chapter will give you an understanding of what you'll need 
to begin using Platinum Paint. There's an explanation of what 
hardware you'll need, as well as some terms which you'll want 
to understand before using the program. 

There are many ways to learn how to use Platinum Paint. The 
method with which you feel most comfortable is obviously the 
best one, but we'd like to recommend that at some point you 
carefully read the entire Platinum Paint manual. Here are 
several methods you may choose: 



.,. Read the entire manual, making note of the important 
features of Platinum Paint. 

.,. Read Chapter One, "Getting Started," and Chapter Two, 
"Using Platinum Paint." 

.,. Use your knowledge of another paint program to 
understand the basic concepts in Platinum Paint. 

.,. Start experimenting on your own. Be sure, however, to refer 
to this manual if you have any questions. 

Required Hardware 
To use Platinum Paint, you'll need an Apple IIGS with a color 
monitor and a mouse, a 3.5 inch disk drive, and at least 1024K (1 
megabyte) of memory. Memory expansion cards from a number 
of manufacturers can be used to increase the amount of memory 
available for use with your Apple IIGs. Platinum Paint can take 
advantage of any additional RAM (beyond the minimum 
requirement of 1024K) that you've installed in the memory 
expansion slot of your IIGs. 

There are several things that you'll need to know to use 
Platinum Paint to its full potential: 

It's essential that you understand how to use the mouse to use 
Platinum Paint. If you haven't read your Apple IIGS Owners 
Manual, be sure to read it before using Platinum Paint. You'll 
want to be sure to understand basic mouse operations such as 
pointing, clicking, and dragging. 

To use the file management features of Platinum Paint most 
effectively, you'll want to have a working knowledge of GS/OS, 
the disk operating system under which Platinum Paint runs. To 
clearly understand GS/OS, be sure to read your Apple JIGS 
System Disk Users Guide. 

3 



Like all Beagle Bros disks, Platinum Paint is copyrighted, not 
copy protected. This means you can and should make a backup 
copy of the disk (use the Finder to make the copy). Use only the 
copy; store the original disk in a safe place away from magnetic 
fields and teething infants. Please make backup copies for your 
own use only. Every illegal copy you give to a friend is a vote for 
copy protection and against friendly software. You support us 
and we'll support you. . 



Platinum Paint Jargon 
Before using Platinum Paint or reading this manual further, it's 
important that you understand several familiar words that are 
being used in this manual in specific ways with regard to 
Platinum Paint. 

Document A document is any drawing that you create at one time with 
Platinum Paint. Documents are stored as files on disks. 

Pixel A document is made up of thousands of tiny little dots called 
picture elements, or pixels for short. The Apple lIes screen is 320 
or 640 pixels wide by 200 pixels high. In Platinum Paint, 
documents are 320 or 640 pixels wide by 400 pixels (one page) 
high. Using the pencil tool, described later, you can change the 
colors on the screen one pixel at a time. 

Selection A selection is a specific area of the document that you choose to 
modify. You can make a quick, rectangular selection with the 
marquee tool, or a more complex, arbitrary selection with the 
lasso tool. Once a selection is made, it can be moved, cut, copied, 
pasted, flipped, slanted, rotated, resized, recolored, masked, and 
so forth. 

Palette A palette is the collection of colors comprising a document. A 
document has a palette of 16 colors, chosen out 4096 possible 
colors. 

Range A range is a collection of colors within the document's palette. 
For instance, you can group all the grays in the palette in one 
range, all the blue-greens in another, and so on. Ranges are used 
mainly by the paint bucket, but can also be used by the lasso, the 
brush and for color cycling. You can define four different color 
ranges for each document. 

Font A font is a set of characters of a particular typeface. A font can be 
colored, boldfaced, italicized, underlined, outlined, shadowed, 
and sized big or small. 
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Mask 

Dithering 

A mask is used to protect certain areas or colors from being 
changed. When an area is masked, nothing can draw over it. 
You can selectively add and remove both areas and colors from 
a document's mask. 

When using 640 mode (where the document is 640 pixels wide 
by 400 pixels high), only four "pure" colors are available. 
Dithering is a technique used to get 16 colors out of four pure 
colors. When two pixels of different colors are next to each other, 
they appear to be one pixel, a mix of the two pure colors. 

In 640 mode, some commands behave differently depending 
whether or not the Dither Lock is turned on. Notes on these 
differences have a Lock icon next to them like the one on the left. 

Command A command is any instruction you give your Apple lIes which 
causes it to perform a specific task. In Platinum Paint, you 
execute commands by choosing them from pull-down menus or 
by typing keyboard equivalents, key combinations which, when 
pressed, perform the same task as choosing a command from a 
menu. 

Modifier Keys Modifier keys are keys that you hold down to modify the way a 
tool or command works. Modifier keys work in conjunction with 
mouse clicks or other keys. 

When using modifier keys in conjunction with mouse clicks, 
hold down the modifier key before clicking the mouse. Once the 
button is down, you may release the key. This also applies to 
using modifier keys with menu commands; hold down the 
modifier before you click on the menu bar. 

Commands that use the Shift key, such as Shift-D for Double, 
require that you hold down the Shift key when typing the letter; 
just pressing D alone with the Caps Lock key down won't work. 



If key translation is set to None (as opposed to Standard), 
modifier keys can work with menu command key equivalents as 
well. For example, Option-Apple-O for Open is the same as 
holding down the Option key and selecting Open from the File 
menu. See Alphabet in the Control Panel reference on page 53 
for more information on setting Option key translation. 

The tools use the modifier keys to change their normal function. 
For example, Apple-clicking the pencil on a pixel in the 
document puts you in FatBits mode, while Option-dragging the 
pencil lets you scroll around in the document. 

You're now ready to begin learning and using Platinum Paint. 
The next chapter, "Using Platinum Paint," shows you how to 
start up Platinum Paint, explainS the Platinum Paint painting 
environment, and includes a short tutorial lesson to make sure 
you understand the basics of creating pictures with Platinum 
Paint. Chapter Three, "Platinum Paint Examples," shows off 
many of Platinum Paint's powerful graphic-editing features. If 
you have questions about using a specific command, refer to 
Chapter Four, "Platinum Paint Reference." 
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Starting Platinum Paint 
Chapter Two will familiarize you with the basic concepts that 
you'll need to know to use Platinum Paint. If you've used 
Paintworks Gold™ or another paint program, then you may 
already know some of the concepts involved in using Platinum 
Paint. This chapter will make sure that you know about the 
Platinum Paint environment and how to use all of the powerful 
tools, and then guide you along step by step as you create your 
first document. 

To start Platinum Paint, you'll first need to boot up your 
Platinum Paint System Disk. 

1. Insert the Platinum Paint System Disk, metal end first 
with the label side up, into your 3.5-inch disk drive. 

2. Turn on your Apple IIGS and your monitor. 
3. The Apple IIGS Finder appears. You'll use the Finder to 

open Platinum Paint. 
4. Place the Platinum Paint Program Disk in the drive. 
5. Double-click on the Platinum Paint icon in the Finder 

window. 

The desktop clears, temporarily replaced by a blank screen 
which says "Platinum Paint." After a few moments, this screen 
clears and the Platinum Paint desktop appears. If you're using a 
one-drive system, you may need to swap between the System 
and Program disks occaSionally. 



The Platinum Paint 
Desktop 

Document WindOVJ 

Title Bar 

Windows and Controls 
The Platinum Paint desktop contains the tools that you'll use to 
create colorful pictures in the document window. Shown below 
is the desktop containing the tool window on the left, the menu 
bar across the top, and the document window in the center. 

The document window is the area in which you paint with 
Platinum Paint. You can work on up to four documents at once, 
and each window contains its own title bar, info bar, scroll bars 
and drawing area. 

The title bar is the rectangular area at the top of the document 
window that contains the name of your document, or 
"Untitled1" if the document hasn't been named. You can move 
the window around the screen by clicking on the title bar and 
dragging it to another location. To move a window that isn't the 
active window, hold down the Apple key while clicking and 
dragging the title bar. 

o Untitled1 ~ 
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The title is the name you give to a document; it appears in the 
center of the title bar. If you've not yet named your document, 
the document's given the name ''Untitledl.'' It's not a good idea 
to actually name a document ''Untitledl,'' because you might 
not know if the document has been saved or not. 

) Unti t 1 ed1 .!. 

The close box, located on the left side of the title bar, is used to 
tell Paint to put the current document away without having to 
choose Close from the File menu. Clicking the close box closes 
the document and clears the document window from the 
desktop. If you've made any unsaved changes, Platinum Paint 
will let you save the changes before closing the document. 
Clicking the close box is identical to choosing Close from the File 
menu. 

The zoom box, located on the top-right side of the title bar, is 
used to toggle between the regular size of the document window 
and a full-screen view of the document that you're working on. 
Click on the zoom box and the document window expands to 
cover the entire screen; click on it again and the document 
window contracts to its regular size. 

To see the part of your document that's not currently on the 
screen, you'll use the scroll bars located on the right and bottom 
sides of the document window. 

To scroll a document, just click on the scroll arrow that 
corresponds to the direction in which you'd like to "move" the 
document window over your document. The white area of a 
scroll bar, called the thumb, will move in the direction that you 
press. Each thumb represents the part of the document currently 
displayed in the document window, and shows you its 
proportional size and position relative to the entire document, 
which is represented by the entire scroll bar (which includes the 
grey area as well as the thumb). 
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The size box, located on the lower-right side of the document 
window, lets you change the size of the document window. By 
dragging the size box, you can change the height and width of 
the document window. 

If you've chosen the Info Bar command from the Window menu, 
you'll see a box called the info bar at the top of the document 
window that displays the cursor coordinates, the current tool 
and the current colors. 

I 69 22 

Like other applications for the Apple IIGS, Platinum Paint uses 
pull-down menus to let you choose commands. 

While you have a menu pulled down, notice that some of the 
commands have characters displayed to their right. These are 
called keyboard equivalents to pull-down menu commands 
because they let you use certain key combinations to perform the 
same tasks as their menu commands. A key command reference 
chart begins on page 112 . 

In Platinum Paint, keyboard equivalents are also called G-key 
commands, because you press the Apple key in conjunction with 
another key to perform a task that you'd normally pull down a 
menu to execute. To perform the Pizza command without 
pulling down the Lunch menu, for example, you'd hold down 
the Apple key and at the same time press the P key; this 
command is represented on the Lunch menu by GP. Pressing 
GP, then, is equivalent to choosing Pizza from the Lunch menu. 

Some menu commands also use the Option key, such as Option­
Resize or Option-Quit. To use the Option key with pull-down 
menu commands, the key must be held down when you first 
click on the menu bar. After that, the Option key may be 
released. 
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Creating a Work 01 Art 
This tutorial will introduce you to some of Platinum Paint's 
basic features. You'll create a gorgeous picture of a California 
sunset in just a few minutes. If you're not sitting at the computer 
right now, go over to it and boot up Platinum Paint. And hurry 
up, because this tutorial moves fast! 

To start off, we'll open a file from the Platinum Paint disk. 

1. Choose Open from the File menu, or press 0 0 for Open. 
2. Press S to move down to the pictures beginning with S. 

Highlight Sunset, then click Open or press Return. 
3. The Sunset document window will appear. It looks 

em pty, for now. 

The first thing we'll do is draw the sun. That's easy enough since 
it's just a circle. 

4. Click on the pen color part of the color selector and drag 
the cursor over the yellow square. This changes the pen 
color to yellow. The pen color is used to color the interior 
of solid shapes. 

Pen COIOT ---1~~:::~~ 
tf:'1-&icJC}l.70UM COIOT 
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5. Go ahead and change the border color to yellow as well 
by clicking on the border color part and dragging the 
cursor over the yellow square. 

Whew! Now that we've got the colors right, we're ready to draw 
the sun. 

6. Click on the right half of the oval tool to draw a filled 
oval. 

7. Hold down the Shift key. This constrains the tool, making 
it draw a perfect circle instead of an oval. 

8. Paint a circle about an inch in diameter, somewhere near 
the middle of the screen, towards the right side. Click and 
drag the mouse diagonally while holding the Shift key. 

Now we'll draw the horizon line. That's about as easy as the sun 
was. 

9. Using the color selector, change the pen color to the 
lightest shade of brown (right next to yellow). 

10. Click on the line tool. 
12. Place the cursor at the left edge of the screen, lined up 

with the middle of the sun. 
13. Hold down the Shift key, then drag a line horizontally 

across the screen, through the middle of the sun. Make 
sure the line goes all the way across the screen, without 
leaving a gap on either side. 

Now we'll remove the bottom half of the sun by filling it in with 
white. 

14. Change the pen color to white, then click on the paint 
bucket in the tool window. 

15. Click the paint bucket on the bottom half of the sun. The 
yellow is filled with white up to the horizon line. 

15 
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Now we're getting to the fun part: filling in the sky and the land. 

16. Choose Fill/Range from the Misc menu. 

Fi II/Range Settings 

Range: @ I 0 I I 
Mix :r::1 ¢%:;"1iIIIIIII~III!!IIII!IIII~9X'"11 

S pee d :L..I O:c..JIIII ___ -..;9:::L.J1 

0111 OIV 

DOn 0 Up 
@Down 

Method:1 Vertica I Gradient ~ 

Respect To:1 Object ~ 

(Sort)(Clear)(Cancel)¢ Ok;'» 

The Fill/Range Settings dialog box appears. This is where you 
tell Platinum Paint what colors to use in gradient fills, and the 
specific type of fill to use. Notice the bottom strip of colors: they 
are all the different shades of blue in the document's palette. 
These are the colors we'll use to fill the sky. 

17. Click on the Method: pop-up menu. Drag the cursor down 
to Vertical Gradient and release the button. 

18. Click on the Respect To: pop-up menu. Drag the cursor 
down to Object and release the button. 

The fill type is now Vertical Gradient. This means that the paint 
bucket will fill with a smooth blend of colors in the blue range 
instead of a solid color, and the blend will flow from top to 
bottom. 



Range Selector 

[Q] 
Hand 

Look at the Mix scroll bar at the top. This shows how much 
"scatter" will be used when gradient filling. The colors aren't 
scattered enough right now for a realistic looking sunset. 

19. Click on the thumb of the Mix scroll bar and slide it about 
1/3 of the way from the left (or choose a mix that looks 
good to you). The rectangle on the right shows the new 
mix setting when you release the mouse button. 

20. Click Ok or press Return to close the Fill/Range dialog 
when you're satisfied with the mix setting. 

Now we're ready to fill in the sky. 

21. If the paint bucket isn't already selected, click on the paint 
bucket icon in the tool window. 

22. Click the bucket in the white space above the horizon line. 
Now we have our sky! 

23. Next we'll paint the desert. Click on the Roman numeral II 
in the range selector in the bottom of the tool window. 
This selects another color range we've already set up for 
you, containing the reddish-browns for the desert color. 

24. Click the paint bucket in the white space below the 
horizon line. The land is filled in, with the lighter browns 
at the top and the darker ones toward the bottom. 

We could stop here and admire our work, but it's not quite done 
yet. For this to be a truly California desert sunset, we need some 
cactus. 

25. Click on the hand tool in the tool window. The hand tool 
lets us scroll around in the document. 

26. Click the hand tool near the bottom of the document 
window and drag up towards the top. The document 
slides up underneath the window's frame. Stop scrolling 
when the cactus is in view. 

17 



18 

. \ 

[0 
lAsso 

One cactus surely won't be enough, so we'll do some trickery to 
make a few different cactuses from this one. First, we'll make 
this cactus into a custom brush. 

27. Click on the lasso tool in the tool window. 
28. Click and drag the lasso around the cactus. You don't 

have to get the lasso real close to the cactus. When you 
release the mouse button, the lasso "shrinks" around the 
cactus and shows a dotted outline indicating the cactus is 
selected. 

29. Choose Brushify from the Edit menu. This takes our lasso 
selection (the cactus) and turns it into a custom brush. 

30. Use the hand tool (or the vertical scroll bar) to move back 
to the top half of the document where our sunset is. 

Our new custom cactus brush can be used to place a cactus 
anywhere you want. Place a cactus or two somewhere in the 
desert by positioning the cactus and clicking. 

··$ ··p··'·e'···'·C'····lal E·.··'e··c·····ts·····,',·W··, .. ··.··I·th····,·th··.·'.··e···,·' C···.U···.·'.S··.···tO·.··'·m·.····.··.·'··B ·ru··.··.··.··.'$···h .. ·'.··,'.·,,·.·,'.·,,·.·,'.·,,·.·,'.·,,"".', . .. :':-':':':':':':':'.':':"':':':':':':':.:'"':.:",:.:.:.:.:.:.:.:.:.:.:.:.:.;.:-',' 

Having only one style of cactus is a bit boring. Let's play with 
the cactus a bit and see what we can come up with. 

31. With the custom cactus brush still active, choose Stretch ------+. from the Edit menu. 
32. Handles appear around the four comers of the cactus. 

Using the mouse, click on one of the handles and drag it 
in the direction you want to stretch the cactus. You can 
grab a handle and stretch the cactus as many times as you 
want. 

33. When you've got the shape you want, click outside the 
dotted outline. Our custom cactus brush is now stretched. 
Place another cactus somewhere towards the middle of 
the desert. 



For a dimensional effect, we'll resize the cactus and place it up 
towards the front of the desert, away from the horizon. 

34. Choose Double from the Edit menu. The cactus is now 
twice its original size. 

35. Click a cactus up toward the lower corner of the window. 
36. Choose the Halve command twice from the Edit menu, 

then choose Flip Horiz, also on the Edit menu. 
37. The cactus is now half its original size, and it's flipped 

horizontally so it won't look just like the other cactus. 
Click the smaller cactus once or twice near the horizon 
line. 

Now we have a large cactus near the front, and smaller ones 
farther back. There-we're done! Our beautiful California sunset 
is complete. If you're feeling artistic, you can add a coyote, a 
roadrunner or two, or anything you like. Let's save our 
masterpiece first, though. 
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We wouldn't want anything to happen to this elegant piece of 
artwork, so we'll save it on a data disk to treasure forever. 

38. Choose Save As from the File menu. 
39. Remove the Platinum Paint disk from the drive and insert 

one of your own data disks. If your disk isn't shown in the 
list box on the left, click the Volumes button, then double­
click on the name of your data disk. 

40. Type the name Desert.Fun in the Save As: box and click 
Save. The Platinum Paint document will be saved as a file 
on your data disk. 

Now we're ready to print this piece. For the sake of this tutorial, 
we are assuming you have an ImageWriter connected to your 
Apple IIGs. If you don't, go ahead and skip this section. 

41. Choose Print from the File menu. 
42. If you're using a color ribbon in your ImageWriter, click 

on the Chroma pop-up menu and select Color. 
43. Click Ok, and watch the beautiful California desert slowly 

emerge from your printer. 

That's all we have time for in this tutorial. For examples of some 
more advanced features, read through the next chapter, 
"Platinum Paint Examples." For explicit details on the use of 
every tool and command, refer to Chapter Four, ''Platinum Paint 
Reference. " 



Chapter Three 

Platinum Paint 
Examples 
". Squishing the Custom Brush 
". Smearing, Blending & Smoothing 
". Colorizing Grayscale Images 
". Animation with Color Cycling 
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Squishing the Custom Brush 
The paint bucket lets you "squish" your custom brush to fit 
inside an irregular shape. Here's a hands-on demonstration of 
this cool effect: 

1. Open the document named Squish.Heads on the Platinum 
Paint Program Disk. Select a head of your choice using the 
lasso tool, then choose Brushify on the Edit menu to turn 
the selected head into a custom brush. 

2. Select the paint bucket tool by clicking on it, then double­
click on it to call up the Fill/Range dialog box. 

3. Select Squish Brush on the Method pop-up menu, then 
click Ok. 

4. Click the paint bucket inside the shapes. Notice how the 
head is squished differently to fit inside each shape. 

5. When you're done having fun squishing one head, try 
choosing Revert and squishing another. Or, draw some of 
your own shapes and continue squishing the head in each 
one. 

Another use of the Squish Brush fill method is for distorting text. 
After typing some text in the desired font, select the text with the 
marquee and then Brushify it. 

Draw a shape that's about the same size as the text you typed­
let's sayan oval. Next, select the paint bucket, then Control-click 
inside the shape. (Control-clicking the paint bucket is a shortcut 
for selecting the Squish Brush fill method in the Fill/Range 
dialog box.) The text you typed is distorted into the shape of the 
oval. 



Smearing, Blending & Smoothing 
This tutorial shows how to make more lifelike objects by 
smearing and smoothing them. This makes objects look less 
geometrical and computerish. First we'll experiment with 
smearing and blending. 

1. Open the document Smear.Demo. A curve is visible in the 
window. 

2. Select the brush tool. 
3. Select the Smear brush method from the top part of the 

Mode menu. 
4. Experiment smearing the curve. Try smearing paint off 

the top of the curve, like water spraying off the top of a 
wave. 

5. Now select Blend mode from the bottom part of the Mode 
menu. 

6. Smear the curve some more. Notice how the paint blends 
together. 

7. Scroll the document down (using the arrows on the scroll 
bars) until a picture of a cloud appears. This cloud was 
created by the same technique, using only Smear and 
Blend. Use a circular motion with the brush to get this 
kind of effect. 

Next we'll try smoothing. The Smooth brush method softens 
edges and slightly blurs the picture to make less granular, more 
natural-looking pictures. 

1. Scroll the document down some more until the circles are 
visible. 

2. Select the Smooth brush method in the Mode menu. 
3. Brush around the edges of one of the circles (leave the 

other circle for a comparison). If you can't tell where you 
are brushing, press the Escape key to show the cursor 
while you're brushing. 

4. Compare the two circles. Then smooth the circle some 
more. 
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Here's an alternate method of smoothing large areas: 

1. Select Revert from the File menu. 
2. Select the marquee tool, then select one of the circles by 

dragging the marquee over it. 
3. Choose Smooth from the Edit menu, and note the 

difference between the two circles. 
4. Press Control-A (for Again, which repeats the last menu 

command) to smooth the selection again. You can use 
Control-A repeatedly until you get the effect you want. 

Colorizing Grayscale Images 
In this example we'll demonstrate how to use Platinum Paint's 
colorizing capabilities using the Wash brush method. Wash 
takes the shade, or brightness, of the color under the brush and 
gives it the hue of the pen color. For instance, painting over dark 
gray with a bright gold pen color results in dark gold. Wash 
works best with a carefully designed palette with several 
gradients of color, as we have set up in this demo. 

1. Open the document Wash.Demo on the Platinum Paint 
Program disk. 

2. Select the brush tool. 
3. Set the brush method to Wash by selecting Wash in the 

Mode menu. 
4. Choose one of the shades of brown in the color selector. 

Wash gives the paint it touches the hue of the pen color, 
with the shade (or brightness) of the paint already on the 
screen. 

S. Run the brush over different areas of the cat, colorizing its 
fur. 

6. Choose one of the blue shades, and then brush over the 
eat's eyes. 



Now we'll demonstrate a faster way to colorize large areas. 

1. Select Revert from the File menu and click Ok. 
2. Double-click the marquee tool to select the whole 

window. 
3. Choose one of the shades of brown in the color selector. 
4. Select Wash from the Edit menu. The entire cat is quickly 

colorized. 
5. Select the brush tool. 
6. Choose one of the shades of blue, and color the cat's eyes. 

You now have a beautiful portrait of Ted Turner's colorized cat. 

SeUlrilrUpa GradlerifPaleUe 

Wash uses the HSV color system, painting over an area with the 
pen color's hue value but with the image's brightness value. The 
key to making Wash work best is setting up the palette with two 
or more gradient ranges of color with similar brightness values. 
For example, to set up a range of 8 grays and a range of 8 reds, 
make the brightness value of the first red close to the brightness 
value of the first gray, the second red value close to the second 
gray value, and so on. 

Here's how to take a 16-color, grayscale picture and colorize it, 
using a palette of 8 grays and 8 fleshtones . 

The colors in the Palette dialog are arranged like this: 

1 8 
9 16 

1. Open the file Gray2Coior on the Platinum Paint disk. 
2. Choose Palette from the Misc menu. 

First you'll make a range of 8 grays, in colors 1 through 8. 
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3. Copy white (color 16) to color 8: click Copy, then click 
color 16, then click color 8. 

4. Blend colors 1 through 8: click Blend, then click color I, 
then click color 8. 

Now you'll make a range of 8 fleshtones in colors 9 through 16. 

5. Change color 16 to a light flesh tone color: set Red to IS, 
Green to II, and Blue to 9. Or choose whatever color looks 
good to you. 

6. Copy color 16 to color 9. 
7. Click color 9, then click Darker until the fleshtone is barely 

visible (but not pure black). 
8. Blend colors 9 through 16. 
9. Click the Remap checkbox. 

Selecting the Remap option causes the 16 grays in the original 
document to be remapped to fit the 8 grays in the new palette. 

10. Click Ok, then click Yes to confirm the palette change. 
11. Set the pen color to one of the flesh tones. 
12. Change the brush method to Wash by selecting Wash 

from the Mode menu. 
13. Brush over the image. Whatever the brush touches is 

colorized. 

After colorizing the flesh areas of the image, you can go back to 
the Palette dialog box and change more of the gray shades to 
other hues by repeating the technique outlined above. 



Animation with Color Cycling 
Open the document named Radar on the Platinum Paint 
Program Disk. Press a -Space Bar to zoom into full screen mode, 
then press the Tab key to start color cycling. 

This demo uses color cycling to simulate an old-fashioned radar 
screen. Four different colors are used to simulate the slowly 
fading traces left behind as the line sweeps around the screen. 

This is how we drew Radar: 

1. First we made a solid black background, using color 1. 
2. Next we drew evenly spaced lines out from a common 

center point, each line in a different color. The first line 
(straight up from the center) was drawn in color 2; 
clockwise, the next line was drawn in color 3, and so on. 

3. Blips were drawn in the color of the line in front of the 
blip (clockwise). 

4. A range was created containing all the colors used to draw 
the lines, in the order we drew them. The first color in the 
range is color 2, then color 3 and 4 and so on. 

5. We modified the palette so that the first color in the range 
(color 2) was a dark gray; color 3 was made a lighter gray; 
and color 4 was made white. The rest of the colors in the 
range were made black. 

6. From the Fill/Range dialog, with color cycling on, the 
speed was fine tuned to get the proper effect. 

It's a good idea to draw the animation with the default palette, 
and not set up the palette for animation until you're done 
drawing. Otherwise, you can't see the animated shapes. 

Try to avoid using colors 1 and 16, as these are used by the 
system to draw windows and menus. Cycling these colors can 
be distracting and irritating. 
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This is the basic outline for creating an animated picture: 

1. Draw a solid background, being sure not to use any colors 
you'll be using for the animation. 

2. Draw the object(s) to be animated in a different color for 
each frame. 

3. Make a range containing all the colors you used to draw 
the object, in the order you want the object to move. 

4. Edit the palette so that the starting frame is the color you 
want the animated object to be. Make each subsequent 
color used in the animation the same as the background 
color. 

5. From the Fill/Range dialog, press Tab to start color 
cycling. Use the Speed scroll bar to adjust the speed, or the 
Up and Down buttons to change the cycling direction. 
Drag the window out of the way if it obscures part of your 
animation. 



Chapter Four 

Platinum Paint 
Relerence 
.,. The Tool Window 
.,. The Info Bar 
.,. Apple Menu 
.,. File Menu 
.,. Edit Menu 
.,. Mise Menu 
.,. Window Menu 
.,. Mode Menu 
.,. Mask Menu 
.,. Font, Size and Style Menus 
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The Tool Window 
The tool window is the group of icons that you see on the left 
side of the Platinum Paint screen. You'll use these tools to create 
different objects in your documents, and to select parts of your 
picture to use with other commands. By mastering the use of 
each of the different tools, you'll become familiar with the best 
ways to use them. 

You can move the tool window anywhere on the screen by 
holding down the Apple key and dragging the window to the 
desired location on the screen. 

The upper portion of the tool window shows the tools. The 
current tool is hilighted in black. To change to a different tool, 
just click on the new tool. 

Keys you can use while painting with the tools: 

~ The # key toggles the coordinate display on and off. 
~ The + key toggles the crosshairs on and off. 
~ The] and [keys switch to the next or previous color. 
~ The' and; keys switch to the next or previous brush shape. 
~ Escape hides the cursor so you can get a better look at what 

you're doing. 

You can use the Return key and the arrow keys instead of the 
mouse when you're working with a very small image. Using any 
of the four arrow keys moves the cursor one pixel in the 
direction you pressed. Holding down the Option key and 
pressing an arrow key moves the cursor ten pixels at a time. 

Pressing the Return key has the effect of pressing the mouse 
bu tton and holding it down; pressing Return a second time (or 
clicking the mouse) releases the mouse button. This lets you do 
very precise clicking and dragging using the keyboard instead of 
the mouse. 
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At the end of each tool description is a list of modifier keys that 
may be used with the tool. With the drawing tools, the Shift key 
usually "constrains" the cursor to paint along a horizontal or 
vertical line. The function of other modifier keys differs with 
each tool. 

When using 640 mode, some tools behave differently depending 
whether or not Dither Lock (on the Misc menu) is turned on. 
These differences are noted with a lock icon at the end of each 
tool description. 

The marquee tool is used to select a rectangular area of the 
document to manipulate. The marquee tool lets you make qUick, 
simple selections. 

Once an area is selected, it can be modified in a variety of ways 
(flipped, slanted, rotated, and so on). The Edit menu shows the 
commands you can use to copy, erase, and modify selections. 

To use the marquee tool: 

1. Hold down the button at the top left corner of the image 
you want to select. 

2. Drag the cursor over to the lower right corner of the 
image. 

3. Release the button. 

A moving dotted outline indicates the area that was selected. 
You can lift the image off of the background by plaCing the 
pointer inside the box and dragging the image to another 
location on the screen. Or, you can quickly make a copy of the 
image by holding down the Option key when you click inside 
the box and drag it. 
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Clicking on another tool or outside the selection deselects the 
image (the box goes away). 

While making a selection: 

U : The marquee shrinks to the smallest box that will fit 
the image's shape. 

Ib]: Doesn't cut the image from the document; instead it 
is copied. 

IICOIllTd I: Lets you make a selection larger than the window by 
scrolling when you drag outside the window. When 
the selection is laid down, it is not cropped on the 
window's edges like it usually is. 

While dragging the selection: 

~: Stretches the selection. 

Ib): Doesn't cut the image from the document. Use this to 
drag a copy of the image away from the original 
selection. 

IloonlTd I: Lets you drag a selection somewhere else in the 
document by scrolling when you drag outside the 
window. 

1bO:J: Constrains the selection to be dragged horizontally or 
vertically. 

Double-clicking the marquee icon selects the whole window. 
Triple-click the marquee icon to select the whole document. 

The lasso lets you select complex images by simply surrounding 
them. This allows for a more complex selection than the 
marquee tool. The lasso will ignore the background color and 
shrink to fit the exact shape of the image. Once selected, the 
image can be modified in a variety of ways (flipped, slanted, 
rotated, etc.) 



To use the lasso tool: 

1. Hold down the button. 
2. Drag the lasso around the object you want to select. 
3. Release the button. The lasso is then tightened, shrinking 

to fit the image's exact shape. 

While making a selection: 

~: The lasso doesn't shrink to fit the image's shape. 

I[contrd I: Selects all adjoining pixels that are the color under 
the lasso's tip (or the colors in the current range, if the 
Shift key is down). Use this to select a solid-colored 
shape by just Control-clicking inside it, instead of 
dragging around it. 

[[;]: Doesn't cut the image from the document; instead it 
is copied. 

~: Shrinks around all the colors in the current range, 
instead of just the background color. 

While dragging the selection: 

~: Stretches the selection. 

[b): Doesn't cut the image from the document. 

I[contrd I: Lets you drag a selection somewhere else in the 
document by scrolling when you drag outside the 
window. 

~: Constrains the selection to be dragged horizontally or 
vertically. 

Double-clicking the lasso icon selects the whole window. The 
lasso will shrink around the background color at the window's 
edges. 

a: When Dither Lock is on, the marquee and lasso are affected 
by allowing even pixels in the image to be dragged only 
onto other even-numbered pixels; otherwise, even pixels 
would be displayed with the odd pixels' color. 
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The hand tool lets you move to a different part of the document. 

To use the hand tool, hold down the button and drag the hand 
around the window until you see what you want, and release 
the button. 

Double-clicking the hand tool brings up the Show Page dialog 
box, described on page 83. Using the Show Page command is 
another way you can move the document around in the 
window. 

The text tool is for adding text to your document in a variety of 
colors, styles, and sizes, plus the ability to left-, center-, or right­
justify the text. 

To use the text tool, just click where you would like to start 
typing. Or, hold down the button and drag the text cursor (a 
blinking bar) where you want it and release the button. 

To move text after you have started typing, hold down the 
Option key and click where you want the text to move. To get 
the text aligned just right, Option-drag the cursor until you're 
satisfied with the placement. 

Turning on Background in the Font menu will clear a 
background beneath the text, which may be useful if you're 
typing over a cluttered background. 

While you are typing, you can use the Delete key to erase the 
last character you typed, or the Clear key to erase the whole line 
of text. 

You'll need to press Return when the cursor reaches the 
window's edge. The cursor will move down to the beginning of 
the next line. You can't type text outside the window, just as you 
can't paint outside it. 



After entering a line of text, you can still change its attributes 
such as the font, size and style before you press Return to accept 
the line. To change the attributes, use the appropriate menu, or 
change the attributes all at once using the Attributes command 
in the Font menu. You can change to the previous or next size in 
the Size menu by pressing a { or a }. 

To change the alignment of the text, press a L, a M, or a R for 
left, middle and right alignment, respectively. 

You can also change its shadow offset and color, if you're using 
the Control key to place a shadow underneath the text. See the 
Shadows dialog box on page 81 for a description of Platinum 
Paint's shadow feature. 

When you're done entering text, press a -Return or the Enter key 
on the keypad. The text cursor will go away, and you can use 
Platinum Paint's keyboard commands normally again. 

See also the reference sections for each of the following: 

T Font Menu 
T Style Menu 
T Size Menu 
T Shadows 

page 107 
page 108 
page 109 
page 81 
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~: Uses the current drawing mode (except Blend) to 
draw the text, instead of Copy. 

[;J Moves the line of text to a new position. 

I[oon~d I: Shadows the text. This effect uses the current shadow 
offset and color set with the Shadows ... command 
and is different from the Shadow option in the 
Attributes dialog and Style menu. 

1I'Iift I: Constrains the text cursor to be dragged either 
horizontally or vertically. 

Double-clicking the text tool icon brings up the Attributes 
dialog, which lets you change the current font, size and style. 
The Attributes dialog box is described on page 107. 

The paint bucket lets you fill an enclosed area with a color or 
pattern. The paint bucket can also fill with a blend of several 
colors, or even squish the brush to fit the area. The color that is 
filled is the color under the tip of the paint pouring out of the 
bucket. 

To use the paint bucket, just click on the color in the document 
you want to fill. The paint bucket uses the fill method you 
specify in the Fill/Range dialog box. You can override this 
setting by using any of the modifier keys below, which let you 
specify the type of fill to use. 



~: Fills normally, using the current pen color or pattern. 

[;J: Fills using the Horizontal Gradient method. 

1E:i)+[;]: Fills using the Vertical Gradient method. 

rr;;]: Fills using the Squish Brush method. 

l[sIifr I: Fills every color in the current range, instead of just 
filling the color under the cursor. The Shift key can be 
used with any of the other four modifier keys. 

Double-clicking the paint bucket icon brings up the Fill/Range 
dialog, letting you set the fill type and range of colors for 
gradient fills. See the description of the Fill/Range dialog box on 
page 74 for more information on the types of fills available. 

a: The paint bucket fills with dithered pixels when the 
Dither Lock is on. When it is off, the bucket fills 
individual pixels. 

The airbrush lets you spray a mist of paint on your picture. You 
can control the speed of the spray. The airbrush can also spray 
ever-lightening or -darkening colors, or even spray custom blobs 
of paint. 

To use the airbrush, hold down the button and drag the mouse 
wherever you want to spray. The longer you leave the airbrush 
in one place, the thicker the paint gets. 

To change the nozzle size, hold down the Apple key and the 
mouse button, dragging the cursor down and to the right until 
the nozzle is the size you want. 

To change the airbrush method or spray speed, use the 
Airbrush ... command on the Mise menu (or double-click the 
airbrush icon.) 
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~: Resizes the nozzle. 

IlsIift I: Constrains the airbrush to be dragged either 
horizontally or vertically. 

Double-dicking the airbrush icon brings up the Airbrush 
Settings dialog box, letting you set the airbrush method and 
spray speed. It's the same as choosing Airbrush ... from the Misc 
menu. 

a: The airbrush sprays dithered pixels if Dither Lock is 
on, otherwise it sprays individual pixels. 

The brush works just like a real paint brush. The brush comes 
with 48 built-in shapes, or you can make your own custom 
brush. The brush can also be used to smear paint, smooth rough 
edges, create a charcoal effect, colorize grayscale images and 
more. 

To use the brush, just hold down the button and drag the brush. 
Or just click to leave a dab of paint. 

Moving the brush quickly can leave gaps between dabs of paint. 
Tum on Connect Brush (Mise menu) to make the brush stay on 
the paper, drawing continuous brush strokes. 

You can make a custom brush by selecting Brushify from the 
Edit menu while a selection is active. See the discussion of 
Custom Brushes on page 40. 



Brush strokes can be mirrored on any combination of four 
mirroring axes. 

See also the reference sections for each of the following: 

T Brushes ... 
T Brush Mirrors ... 
T Mode Menu 
T Squish Brush 

page 73 
page 73 
page 97 
page 75 

~: Constrains the brush to paint either horizontally or 
vertically. 

t;l Option-clicking the brush icon selects the custom 
brush. 

Double-clicking the brush icon brings up the Brushes dialog, 
letting you select a different brush size or shape. 

You can switch to the next or previous brush shape using the; 
and' keys, even while you're painting. 

a: When Dither Lock is on, the brush is affected by 
allowing even pixels in the image to be dragged only 
onto other even-numbered pixels; otherwise, even 
pixels would be displayed with the odd pixels' color. 
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Besides the 48 built-in brushes, Platinum Paint lets you create 
your own custom brush. Custom brushes are like miniature 
documents, having their own palette, and can be loaded or 
saved. In fact, documents can be loaded as brushes, and brushes 
can be loaded as documents. 

If the custom brush's palette is different from the document's 
palette, it can be remapped to fit the document's palette the best 
it can. 

To make your own custom brush, make a selection with the 
marquee or lasso tool, and choose Brushify in the Edit menu. 
The current tool changes to the brush, and you can begin 
painting with your new custom brush. 

The Edit menu shows all the operations that can be performed 
on the custom brush. Usually, any operation you perform with a 
marquee or lasso selection can also be done with the custom 
brush. 

If you copy a custom brush to the clipboard, the palette is stored 
on the clipboard with the brush's image. This way, if you paste 
the brush into another document with a different palette, you'll 
be given the option of remapping colors (in the document or the 
brush itself) to best fit the new palette. 

To save your custom brush on disk, choose Save Brush from the 
File menu. This command works just like Save As on page 55, 
only the custom brush is saved instead of the document. We 
recommend creating a folder on your disk called ''Brushes'' for 
storing custom brush files; that way you won't get Platinum 
Paint documents confused with custom brush files. 



When you load a custom brush from disk that has a different 
palette than the document you're working with, you have the 
option of using the custom brush's palette, or remapping the 
brush to fit the document's palette. See the description of the 
Brush Palette, Remap Brush and Remap Doc commands on 
pages 64 and 65. 

The pencil lets you draw freehand lines, just like a real pencil. 

To use the pencil, simply hold down the button and drag the 
pencil. Clicking on a pixel that is the same color as the pen color 
makes the pencil erase. 

The pencil always draws one pixel wide, and is not affected by 
the line size selector in the tool window. 

Holding down the Option key changes the cursor to the hand 
tool, letting you move to another part of the document. Apple­
clicking the pencil anywhere in the window zooms into FatBits. 
The spot you click the pencil on will be the area shown in the 
FatBits window. 

IU: Zoom into FatBits, showing a 4x blowup of the area 
you clicked. 

1[;]: Changes the pencil to the hand tool to move the 
document. 

Ilsliff I: Constrains the pencil to draw either horizontally or 
vertically. 

Double-clicking the pencil icon turns FatBits on and off. The 
FatBits editing mode is described on page 72. 

iI: The pencil draws dithered pixels when Dither Lock is 
on, otherwise it draws individual pixels. 
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l2J The line tool draws lines in the pen color with the current line 
size. Lines can also be shadowed or constrained to 45 degree 
angles. 

To use the line tool: 

1. Hold down the button on one endpoint. 
2. Drag the line to the other endpoint. 
3. Release the button. The line will be drawn in the pen 

color. 

~: Draws the line with the current drawing mode, 
instead of Copy. 

ibl Draws the line in the border color. 

fri!sh=·n= ""I: Constrains the line to be a horizontal, vertical, or 45 
degree line. 

i!""'&-d I: Shadows the line, using the current shadow offset 
and color defined in the Shadows dialog box (page 
81). 

The eraser lets you erase parts of your document, just like an 
eraser on a blackboard. The eraser always erases with the 
background color. 

To use the eraser, just hold down the button and drag the eraser 
over the area you want to erase. 

~: Constrains the eraser to erase only horizontally or 
vertically. 

Double-click the eraser icon to quickly erase the entire window. 
The window will change to the background color. Note that only 
the part of the document visible in the window is erased. 



The shape tools (box, rounded box, oval, curve, freehand, and 
polygon) are split in half. The left half of the icon only draws the 
shape's border, and the right half of the icon draws a filled-in 
shape. Each shape is described in detail below. 

These tools draw their respective shapes using the current pen 
and border colors. 

To use the box, rounded box, or oval tools: 

1. Hold down the button at the top left corner of the shape. 
2. Drag the cursor to the lower right comer of the shape. 
3. Release the button. 

You can draw these shapes from their centers out, instead of 
from corner to comer, by turning on Center in the Misc menu. 
To draw with Center turned on, click where you want the center 
of the shape to be, and drag it to the size you want. 

[U: Draws the shape in the current drawing mode, 
instead of Copy. 

Ib): Draws the shape without a border. This is (obviously) 
only useful when using one of the filled shapes. 

Ilsiin I: Constrains the shape to be square or circular. 

l[oonO'd I: Shadows the shape. 
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The curve tool lets you draw three point or Bezier curves. You 
specify the type of curve to draw and the number of points 
along the curve in the Curve Settings dialog box, described on 
page 80. 

To use the curve tool with three point curves: 

1. Hold down the button on one endpoint. 
2. Drag the line, positioning the other endpoint, and release 

the button. 
3. Drag the curve to the shape you want and click the 

button. 

A Bezier curve has four control points and can be edited before 
it is drawn. To use the curve tool with Bezier curves: 

1. Hold down the button where you want the first point to 
be. 

2. Drag the cursor to the next point and release the button. 
3. Repeat step 2 until all four points have been placed. 
4. After the four points have been placed, the curve is 

drawn, with handles on each of its four points. 
5. To change the shape of the curve, drag one of its handles. 
6. Double-click the mouse when you get the right shape. 

IU: Draws the curve in the current drawing mode. 

1[;]: Draws the curve without a border. 

IloonlTd I: Shadows the curve. 

Double-clicking the curve icon brings up the Curve Settings 
dialog box, letting you set the type of curve and number of 
"smoothness" points. 



The freehand shape tool lets you draw any irregular shape. 

To use the freehand shape tool, hold down the button and drag 
the mouse around. If you don't close the shape, a line will be 
drawn from the endpOint back to the starting point, closing the 
shape for you. 

[~:i]: Draws the shape in the current drawing mode. 

Ib): Draws the shape without a border. 

1[""'lTd I: Shadows the shape. 

A polygon is a shape made up of three or more connecting lines. 
The polygon tool can draw a solid polygon or just the outline of 
the polygon. 

To use the polygon tool: 

1. Click the button on one endpoint. 
2. Drag the line, positioning the other endpoint, and release 

the button. 
3. Repeat step 2 as often as desired. 
4. Double-click, or click outside the window to finish the 

polygon. 

~: Draws the polygon in the current drawing mode. 

Ib): Draws the polygon without a border. 

r.=1[sNn=' = ""'1: Constrains the current line to be a horizontal, vertical, 
or 45 degree line. 

1[""'lTd I: Shadows the polygon. 
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The dropper lets you change the pen color by clicking on a color 
in the document. Use it when you can't distinguish a color from 
similar colors in the color menu. Simply click the dropper to 
suck up a drop of paint and make it the new pen color. 

You can click and drag the dropper around the document, and 
the color selector shows the color under the dropper's tip. 
Release the button when the right color is displayed. 

By holding down the Control key, you can flash the color under 
the dropper to see all the places a particular color is being used. 
Just Control-drag the dropper over the picture until the color 
you want is flashing. 

~ Note: The dropper tool doesn't have an icon in the tool 
window, so you must press! (Shift-1) to select it. 

To change the pen color, just click on the color in the document 
that you want. To change the border color, Apple-click on the 
color. To change the background color, Option-click on the color. 

As soon as you release the button, it reverts back to the previous 
tool you were using. 

~: Change the border color. 

[r;l Change the background color. 

[[""'lTd I: Flash the color under the dropper. 
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Pop-up Color Menu 
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The color selector lets you change the pen, border, and 
background colors. The pen and border colors can also be 
patterns. 

Pen Color 
-BrlckJUOl~nd Color 

+-I'Wrd'pr Color 

The pen color is used by all the drawing tools. It's also the color 
used to fill the interior of solid shapes. The border color is used 
to draw borders for the shape tools. 

Think of the background color as the "paper" color. Any erasing 
(with the eraser, or cutting out an image) is done with the 
background color. 

To change a color: 

1. Hold down the button with the cursor on the color you 
want to change. A pop-up color menu appears, showing 
the 16 palette colors and 16 patterns. 

2. Drag the cursor onto the color or pattern you want and 
release the button. If you decide you don't want to change 
the color, just move the cursor outside the color menu and 
release the button. 

Ir:l Holding down the Option key while selecting a color 
flashes the color under the cursor. Use this feature to see 
where a particular color is being used in the document. 
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Option-clicking the color selector (that is, holding down the 
Option key before clicking the color selector) brings up the 
Palette dialog, letting you modify the colors in the document's 
palette or select a new palette. The palette editor is described on 
page 84. 

You can select the next color or pattern by pressing the] key; 
pressing the [ key selects the previous color or pattern. 

Below the color selector is the line size selector. This controls the 
size of lines for the line tool, and the size of the border for the 
shape tools. The topmost, dotted line means that no border will 
be drawn. 

Height I·' ........... i 1 Width 

To change the line size, just click on the line thickness you want. 
To change just the line height, click to the left of the line 
thickness. Predictably, clicking to the right of the line thickness 
changes just the line width. 

1IiII: When Dither Lock is on, the smallest line width is 
one dithered pixel (two 640 mode pixels). When it's 
off, lines can be one pixel wide. 
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The range selector lets you choose which will be the current 
range. Ranges are used mainly by the fill tool, but can also be 
used by the lasso (to shrink around more than one color), and 
the brush (using the Charcoal or Cycle brush methods). 

The range selector has four icons, the Roman numerals I through 
IV. Clicking on an icon selects that range. Double-clicking on an 
icon calls up the Fill/Range dialog, letting you edit the range 
you double-clicked. Color ranges and the Fill/Range dialog are 
described on page 74. 

149 



50 

The Inlo Bar 
The info bar shows the cursor coordinates, delta coordinates, 
current tool, current colors and the dither lock status. It's most 
useful in Full Screen mode or when thL tool window is hidden. 
If the info bar isn't displayed, you can tum it on by choosing 
Info Bar from the Window menu. 

1187 66 6 68 16 

Depending where the window is on the screen, you may not be 
able to see all of the info bar. One way to solve this is by using 
Full Screen mode. 

If the Coordinates option in the Window menu is turned on, the 
position of the cursor is reported starting at the left edge of the 
info bar. While drawing, the delta coordinates (the offset from 
the starting point) are displayed immediately after the Cllrsor 
coord ina tes. 

Clicking on the tool icon makes a pop-up menu appear, showing 
all the tool icons. Just drag the cursor over the tool you want and 
release the button to select a new tool. 

The current colors are shown next to the tool icon. Changing the 
colors in the info bar works the same way as changing them 
from the color selector in the tool window. Just click on the color 
you want to change, and drag the cursor over the new color or 
pattern. 

If the Dither Lock option (in the Misc menu) is on, a lock icon is 
displayed. If you're working with the Spare Page, an '5' is 
shown. 



About Platinum Paint 

Apple Menu 
The Apple menu at the far left of the menu bar contains one 
command, About Platinum Paint, and a list of desk accessories 
you have installed in your system. 

About Platinum Paint displays a box giving the current version 
number, copyright information, and the amount of available 
memory. 

Each document window you open requires a 62K block of 
contiguous memory, in a single 64K bank. If you get a message 
stating you can't open another document because there isn't 
enough memory, even though the About box shows plenty of 
memory available, it's probably because memory has become 
fragmented. That means there is data stored throughout memory 
that cannot be moved to create more contiguous free space. To 
get around this, close any desk accessories or document 
windows you may have open, free the mask, or kill the spare 
page. 

Each document can have its own mask, each of which requires 
an additional62K chunk of memory. The Spare Page, which is 
shared by all open documents, also requires 62K. 
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When you select Control Panel from the Apple menu, a desk 
accessory window appears on the screen, letting you select a 
printer or change other operating characteristics of your IIGs. 

DC Pt·intet· 

II 
General 

1:I11III: wi 

Keyboard 

Se I ect a Port: 

Ca!!'!!' I:l 
Se I ect a Printer Type: 

C'I'HIMIli!' I:l 

On the left side is a strip of icons called Control Panel Devices, 
or CDevs for short. The CDevs relevant to using Platinum Paint 
are described below. 

Clicking on the DC Printer CDev lets you select a direct-connect 
printer driver and printer port. Select the printer type (such as 
ImageWriter) in the lower right by clicking on its name, then 
click on the appropriate port (Printer or Modem) in the upper 
right. Platinum Paint will then use the printer driver and port 
you selected. 

To close the Control Panel, click the close box on the left side of 
the title bar or choose Close from the File menu. 



~ 
LaserWri ter 

Aa 
n9(j 

Alphabet 

This CDev lets you select a LaserWriter when you've connected 
your IIGS to an AppleTalk network. Refer to your Apple IIGS 
System Disk User's Guide for infonnation on installing the 
AppleTalk and LaserWriter drivers on your System Disk. 

Select the LaserWriter by clicking its name in the list box on the 
upper right. If you're on a multiple-zone network, click on the 
zone name in the list box on the lower right, then select the 
printer in the first list box. 

It's not necessary (or recommended) that you download the 
ImageWriter Emulator when using Platinum Paint. 

The User Name line at the bottom identifies your computer to 
the rest of the devices on the network. Changing the User Name 
takes effect after you restart your IIGs. 

The Monitor and Keyboard options in this CDev aren't used 
with Platinum Paint, so they won't be described here. We're 
mainly concerned with the Translation setting. 

The Translation pop-up menu lets you set the Option key 
translation. When it's set to Standard, you can use the Option 
key to type in the alternate character set (with foreign language 
accents and special symbols). However, you can't use the Option 
key with other keyboard commands, such as Apple-Option-Q to 
quit and save the clipboard. 

Setting Translation to None lets you use the Option key with 
keyboard commands, but you won't be able to type characters 
from the alternate character set. The default setting is Standard, 
but you're free to change it if you want. 
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File Menu 
Creates a new Platinum Paint document. The default palette and 
patterns are used and the drawing area is cleared to white. You 
can have up to four documents open at once. 

Opens a Paint document from a disk. Choose a document by 
clicking on a name and then clicking Open, or by double­
clicking the name. 

Open: 
Gn:P I atinum.Paint: 

••• . :~J {Q: [ Volumes ) 
CI Desktop.Screen r=-
CI Ket,t.Hodi tiers 
CI Hode.Samp I es « Open ) CI Rebecca 
CI Sophie ( Close ) CI USA.Hap 

{r CI Wash.Demo .( Cancel ) 

Files are listed alphabetically. You can quickly jump to a group 
of files by typing the first letter of the filename. In the dialog 
above, typing an 5 would move the selection bar down to 
Sophie. 

You can open a folder by selecting it and clicking Open, or by 
double-clicking its name. 

The Volumes button lets you change disks. When you click 
Volumes, Platinum Paint lists the disk in each drive connected to 
your IIGs. Select a disk by clicking the disk name and clicking 
Open, then choose a file or folder from that disk. 



Close tiW 

Save tiS 

Save As ... 

The Close button closes the current folder. In the dialog box 
shown above, the files listed are contained on the disk named 
Platinum.Paint. You can also close the current folder and return 
to the previous one by clicking on the folder name above the list 
box. If you click when just the disk name is shown, the list of 
disks will be displayed as if you had clicked the Volumes button. 

Ib): Holding down the Option key while choosing Open opens 
the picture into the current window, replacing any picture 
already there. 

Platinum Paint can also open pictures stored in Apple II Hires, 
Double-Hires, Print Shop, and MacPaint format. See the Import 
command on page 57. 

Closes the current window. If you've made changes, Platinum 
Paint asks you if you want to save it first. Another way to close a 
window is to click its close box. 

Ib): Option-Close closes all open document windows. 

Saves the current document. The document is saved on the same 
disk (or in the same folder) from which it was originally opened. 

If you haven't named a new document you're working on, use 
the Save As command instead. Pressing OS with an untitled 
document will perform the Save As command automatically. 

Saves the current document, letting you save it with a different 
name, on a different disk, or in a different format. 
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~:P I atinum.Paint: 
11211 free of 800 k. ( Volumes ) 

ut' '(~!'. t' \~ ~; 
) C:: f::i nd~B· .th!'~; t< t o~> ( H@w Fold@r 

c: K ~~u. H~>d i t::i ~~n; 
( ) c: H<~d~~. ~~om~> 1 ~!'~; O~H~n 

c: t" ~H t-H .0 H. ·nl ) <"4 t" 1 ~:I t inunL r> <d n~~ ( Clos@ 

ave as: I¢ ) Save I &!LiEl Canc@l ) ( 
@ Appl@ Preferred OSHR 

Type the name for your picture in the Save As: box, then click 
Save. 

The Open button is used to open a folder. The Close and 
Volumes buttons work the same way they do in the Open 
command on page 54. 

The New Folder button lets you create a folder on your disk. 
You can use folders to help organize your pictures. To create a 
new folder, type the folder name in the Save As: box, then click 
New Folder. 

The Apple Preferred and SHR radio buttons let you specify the 
format of the saved picture. Apple Preferred is the default 
setting, and is the standard format for paint program 
documents. The SHR setting will let you save the document as 
an uncompressed Super Hi-Res screen file, for use with 
programs and desk accessories that require this file type. 

Restores the current document to the version that was last saved. 
Use this when you've made extensive changes to a picture that 
Undo can't fix. 



Load Brush ... 

Save Brush ... 

Imporl ... 

MacPaint 
Doub 1 e HiRes 
HiRes 
Print Shop 
Print Shop GS 

Loads a custom brush from disk and makes it the new custom 
brush. The current tool changes to the brush tool so you can 
begin painting with the brush you just loaded. 

Saves the custom brush. This works just like the Save As 
command, except the custom brush is saved to disk instead of 
the picture. You can make any selection into a custom brush by 
using the Brushify command on the Edit menu (described on 
page 65). 

Lets you import graphics from Apple II HiRes, Double HiRes, 
Print Shop, or MacPaint. A standard Open File dialog is 
displayed, similar to the Open command on page 54. There is a 
pop-up menu at the bottom that gives several choices for the 
type of graphic to import. 

After selecting a MacPaint file to import, a dialog is displayed 
that's similar to the Show Page dialog. You are shown a full­
page view of the MacPaint document, with an outline box 
showing the part of the MacPaint picture you can import into 
your Platinum Paint document. Using the mouse, move the box 
over the part of the picture you want to import, then click Ok or 
press Return. 

The Fix Aspect Ratio option halves the height of the MacPaint 
picture to maintain the proper aspect ratio. This is most useful in 
640 mode; pictures imported in 320 mode don't need this option. 

~ Note: MacPaint pictures must be in ProDOS format. Use 
Apple File Exchange on your nearest Macintosh to transfer a 
MacPaint file to a Binary (type $06) or typeless (type $00) file 
on a ProDOS disk. 
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After selecting a file to import, a dialog is displayed that looks 
remarkably similar to the Show Page dialog. You are shown a 
full-page view of your document. HiRes screens are smaller than 
Platinum Paint documents, and an outline box indicates the size 
of the imported screen. Use the mouse to move the box to the 
desired location in your document, then click Ok. The graphic 
will be pasted into the document where you moved the box. 

The Color check box detennines whether the graphic is 
imported in color or monochrome. 

When Use HiRes Palette (or Use Double HiRes Palette) is 
checked, the document's palette is replaced by the imported 
graphic's palette so the colors will look right. When it is off, the 
graphic's colors are remapped to best fit the current palette. 
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When you import a Print Shop or Print Shop GS graphic, the 
image is placed on the clipboard. Use the Paste command to 
paste the graphic into your document. If you paste a Print Shop 
GS graphic, you're given the option of remapping colors in the 
graphic or in the document to best fit the new palette. See the 
description of color remapping on page 63. 

~ Note: Print Shop graphics (not Print Shop GS graphics) must 
be in ProDOS format. If you have Print Shop graphics in 
DOS 3.3 format, copy them to a ProDOS disk using a 
conversion program such as Copy II Plus or Apple System 
Utilities . 



Animate ... 

Page Setup ... 

Lets you animate a Paintworks animation sequence. 

A dialog is displayed, letting you choose the animation you 
would like to see. Select a sequence and click Open, and the 
sequence is automatically animated. Click the mouse to stop the 
animation and return to your document. 

Lets you change printing options like 50% reduction, portrait or 
landscape orientation, or paper size. 

ImageWriter/Printer v4.0 

Paper T~pe: 

Reduction: 

Height: 

Orientation: 

US Letteroo .... 8.:>"x11" • 

Full Size 

D Ho Vertica I Gaps 
D Vertica I Condense 

I~ I (Cancel) « OK )) 

The Reduction option lets you print out the document in its full 
size or half its normal size, giving slightly better resolution. 

Platinum Paint documents are large enough to fill an 8.5" x 11" 
page with no gaps between pages. If you have drawn on the 
extreme bottom of the page, the last portion of the drawing may 
not be printed unless you select No Vertical Gaps. 

The Vertical Condense option lets you specify how graphics 
should look when printed . When you print pictures containing 
circles or other round objects, turn Vertical Condense off. When 
printing a picture that contains mostly text, turn it on. The 
picture will be condensed vertically, which makes text look 
good, but circles look squashed. 
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LaserWriter Users 
In the LaserWriter's Page Setup dialog box, the Smoothing 
option smooths bit-mapped graphics so they look more natural, 
less blocky. 

The Font Substitution box isn't used with Platinum Paint, since 
text is stored as a bit-mapped image in your picture, instead of 
real text with font attributes (like a word processor stores text). 

You can reduce or enlarge the image from 25% to 400% by 
typing a percentage in the size box. 

Prints the Paint document. A dialog appears letting you select 
the number of copies, color printing, and print quality. 

ImageWri ter~Printer v4.0 

Cop i e s: IL..[]~ __ --I 

Pages: @AII ORange 
From 
To 

Quality: 

Chroma: 

Sheet Feed: 

Standard ~ 

B I ack~Whi te ~ 

Automatic ~ ( Cancel) 

¢ OK D 



Text Only 
Fast 
Standard 
Best 

Quit _Q 

Use Fast mode when you want to check the placement of items 
on the page. The print quality isn't great, but it prints a lot faster 
than Standard or Best. 

Use Standard or Best mode when you want to print your final 
copy. In Platinum Paint, the print quality and speed are about 
the same. 

The Text Only mode doesn't work with Platinum Paint, since all 
images (including text) are stored as graphics, not "real" text like 
a word processor. 

Platinum Paint documents are always only one page long, so 
selecting a range of pages has no effect. 

Set the Chroma to Color if you're using a color ribbon in the 
ImageWriter. The Chroma option can't be set to Color unless a 
color ribbon is installed. 

During printing, pressing O. (Apple-Period) cancels printing 
and returns you to your document. 

LaserWriter Users 
There are no print quality or color options in the Print dialog box 
for the LaserWriter. The other options work as described above 
for the ImageWriter. 

Quits Platinum Paint. All documents are closed. If any of the 
documents have been changed, you are first asked if you would 
like to save each changed one. 

1[;]: Option-Quit saves the clipboard contents in the System 
folder on your startup disk before quitting. Use this when 
you plan to paste the contents of the clipboard into another 
program. 
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Cut .x 

Copy .C 

Paste .v 
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Edit Menu 
The Edit menu contains commands that let you copy, erase, and 
modify selections. You can repeat any command on the Edit 
menu by using the Again command (Control-A). For example, to 
make a selection four shades lighter, you would choose the 
Lighten command, then press Control-A three times. 

Reverses the last change you made, restoring the drawing area 
to the state it was in before the change was made. If Undo is 
selected again, you can flip between the last change made and 
the state of the drawing before the change. Changes made to the 
whole document cannot be undone. 

Cuts the selection to the clipboard, removing it from the 
document. The selection can then be pasted into another 
document or even into another program or desk accessory. The 
previous contents of the clipboard are replaced. When you cut a 
selection from the document, the selected area is erased with the 
background color. 

Puts a copy of the selection on the clipboard. It works just like 
Cut, except the selection is not removed from the document. 

Pastes the contents of the clipboard. The new selection is 
centered in the window. 



Ib]: If the selection you paste is larger than the window, it will 
be cropped on the edges to the size of the window. You can 
hold down the Option key when pasting to resize the 
selection to fit inside the window. 

1[;): If an area is already selected on the screen, and you hold 
down the Option key when pasting, the clipboard image is 
resized to fit the dimensions of the selection. (Normally, 
the clipboard image you paste simply replaces the 
selection.) 

If the new selection's palette is different from the current palette, 
the following dialog appears: 

The selection's palette is 
di fferent from the current pa I ette. 
@ Remap selection to fit palette 
o Remap document and use se I ection' s 

palette o Use selection's palette 
( Do Nothing ) [~=D=o=I=t=~D 

When the selection's palette is different from the document's 
palette, it won't look right. Platinum Paint provides color 
remapping to make the selection fit in with its new environment, 
or to make the environment fit in with the new selection. 

Color remapping looks at each color in the original palette, and 
picks the best matching color in the new palette. Areas in the 
selection or document are recolored with the best matching 
colors from the new palette. This feature makes an image fit a 
different palette, and still maintain its original coloration, 
assuming there are enough closely matching colors in both 
palettes. 
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Remap selection to tit palette 
Remaps the selection to fit the current palette. If the selection's 
palette doesn't match the current palette closely enough, 
remapping may not help. If you're not sure what to do, choose 
this option and click Do It. 

Remap document and use selection's palette 
This option lets you remap colors in the document to best fit the 
selection's palette, and changes the document's palette to that of 
the selection. 

Use selection's palette 
The document's palette becomes the selection's palette, but no 
remapping takes place. 

Select one of the three remapping methods and click Do It. If you 
want to continue to use the document's palette without 
remapping colors in either the selection or document, click Do 
Nothing instead. 

~ You can quickly copy a custom palette from one document 
into a new document, replacing the default system palette. To 
do so, copy any selection from the old document to the 
clipboard, then paste the selection in the new document. When 
the Remap Colors dialog (above) appears, choose "Use 
selection's palette" and click Do It. Press Clear to remove the 
selection, if desired. The new document now has the same 
palette as the original document. 

Clears the selection to the background color. You can also use 
the Clear or Delete keys. 

Changes the current palette to the custom brush's palette instead 
of the document's palette. This change is not permanent; you can 
change back to the document's original palette by selecting 
Brush Palette again. 



Remap Brush 

Remap Doc 

Remaps all the colors in the custom brush to best fit the colors in 
the document's palette. 

Remaps all the colors in the document to best fit the custom 
brush's palette. 

Brushify tI, Changes the selection into the custom brush. The selection is cut 
(Apple-Comma) from the document, and the current tool changes to the Brush 

tool. 

Invert N 

Lighten 

Darlcen 

You can save the custom brush to disk using the Save Brush 
command on the File menu (see page 57). 

Reverses all the colors in the selection or brush. This is like 
flipping the palette upside down. This is most useful with black 
and white or grayscale pictures to see the negative of a picture. 

Lightens the selection or brush by shifting all the colors in the 
current range up one. Colors in the selection that are not in the 
current range are not affected. If there are no colors in the 
current range, all colors will be shifted. Lighten requires the 
range to be ordered from darkest to lightest. This is most useful 
with the built-in grayscale palette and palettes containing 
several gradients of the same hue. 

Darkens the selection or brush by shifting all the colors in the 
current range down one. Colors in the selection that are not in 
the current range are not affected. If there are no colors in the 
current range, all colors will be shifted. Darken requires the 
range to be ordered from darkest to lightest. Like the Lighten 
command, this is most useful with the built-in grayscale palette 
and palettes containing several gradients of the same hue. 
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Shade takes the hue of the colors in the selection and gives them 
the shade, or brightness, of the pen color. For example, painting 
over dark green with a light blue pen color results in a light 
green. Shade works best with a carefully designed palette with 
several gradients of color. 

Wash takes the shade, or brightness, of the colors in the selection 
and gives them the hue of the pen color. For example, painting 
over dark gray with a bright red pen color results in dark red. 
This is excellent for colorizing grayscale (or scanned) images. 
Wash works best with a carefully designed palette with several 
gradients of color. See the example "Colorizing Grayscale 
Images" on page 24 for an example of Wash. 

Smooths the edges of the colors in the selection. Smooth has the 
effect of blurring the image. It's excellent for smoothing out 
high-contrast areas, or creating more subtle, lifelike shading. 

Lets you remove areas in the selection or brush that are a certain 
color. The cursor changes to the color picker cursor. If the info 
bar is turned on, the color underneath the color picker is shown 
on the left. When the cursor is over the color you want to 
remove, click the button. The selection is redrawn with holes 
where the color was. 

Lets you change one color in the selection or brush to another 
color, kind of like Find and Replace in a word processor. The 
cursor changes to the color picker cursor. When the cursor is 
over the color you want to replace, click the button, then move 
the cursor over the new color and click again. The selection is 
redrawn with the color changes. Turning the info bar on makes 
it easy to see what color is underneath the color picker. Both the 
Find and Replace colors are displayed. 



Flip Horiz X 

Flip Veri Y 

Mirror Horiz 

Mirror Veri 

Halve d 

Double D 
(Shift-D) 

Flips the selection or brush from left to right. 

Flips the selection or brush from top to bottom. 

Mirrors the left half of the selection or brush onto the right half. 

Mirrors the top half of the selection or brush onto the bottom 
half. 

Halves the size of the selection or brush. 

Doubles the size of the selection or brush. 
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Stretch 

Slant 
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Stretches the selection or brush. Handles appear on the selection. 
Click on a handle and drag it to the size you want. You can 
stretch the box as many times as you want. Clicking outside the 
selection or its handles makes the stretch permanent (at least 
until you choose Undo). 

fb): If you hold down the Option key and choose Stretch, the 
Resize dialog appears. Type the percentage to reduce or 
enlarge the selection by and click Ok. 

Resize by 175 1% 
[Cancel] ¢ Ok D 

Slants the selection or brush. Handles appear on the selection. 
Grab a handle and drag the box in the direction you want to 
slant the image. The direction you first move the mouse after 
clicking on a handle is the direction the selection will be slanted, 
just like when constraining the pencil. For example, if you first 
move the mouse up, then the image is slanted vertically, 
otherwise it is slanted horizontally. 

When you get the effect you want, click outside the selection or 
its handles to make the Slant permanent (at least until you 
choose Undo). 

J------------~ /// :r'ks/// 
~------------Q. 



Rotate 

Perspective 

Rotates the selection or brush by any angle. Handles appear on 
the selection. Grab a handle and drag the box to the angle you 
want, and release the button to see the rotated selection. If the 
Info Bar and Coordinates are on, the angle is shown in the info 
bar. 

[6:]: When you hold down the Option key and choose Rotate, 
the Rotate dialog appears. Enter the degree of rotation and 
click Ok. 

Rotate 1351 1 0 

[Cancel)« Ok D 

Gives the selection or brush a perspective effect. Handles appear 
on the selection. Drag a handle and distort the selection in the 
direction you want. The direction you first move the mouse after 
clicking on a handle is the direction the selection will be 
distorted. When you get the perspective effect you want, click 
outside the selection or its handles to make the effect permanent. 
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Cast Shadow @ 

Picl(up 

Collapse K 
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Casts a shadow of the selection or brush under the selection or 
brush, using the current shadow color and offset. See the 
description of the Shadows ... dialog box on page 81. If selected 
with a custom brush, Platinum Paint first allows you to position 
the brush before placing the shadow. 

This command picks up only the image underneath the selection 
while keeping its shape. For example, make a round selection by 
selecting an oval with the lasso. Then move the selection over a 
smaller object that fits inside the oval, and choose Pickup. The 
selection now contains the image underneath it, but in the 
original oval shape. The image underneath the selection is not 
affected by this command. 

This command collapses the marquee around the object in the 
selection or brush image. The object then appears as if you had 
selected it with the lasso instead of the marquee. Think "shrink 
to fit." 



Dither Loclc ,,0 

Center 

ConneclBrush C 

Grid g 

Mise Menu 
Toggles the Dither Lock. This is useful only in 640 mode. Dither 
Lock works like a mini-grid that keeps all drawing on even 
coordinates so dithered colors look right. For instance, if you 
drag a marquee selection with the Dither Lock off, the colors in 
the selection seem to change every time you move it 
horizontally. Turn Dither Lock on to prevent that effect. 

See also the discussion of dithering in 640 mode on page 90. 

Toggles centered shapes. Boxes, round boxes, and ovals are 
drawn from the center instead of the corner. The center of the 
shape is where you first click the button. 

Toggles connected brushes. When this is on, brush strokes are 
connected with lines instead of leaving gaps. This is like 
dragging the brush on the paper instead of dabbing it. 

~@: (H~ 

0 : 

0& • Q: ~ 
Off On 

Toggles the grid. When drawing with the grid on, all drawing is 
aligned to the grid points. The grid works with all the shapes 
(except the freehand shape), brushes, pencil, and text. The eraser 
and lasso tools aren't affected by the grid. 

Use the Grid Size command (Shift-G) to adjust the size of the 
grid. The Grid Size dialog box is described on page 82. 
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FatBUs elF 

Cycle Colors Tab 
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Zooms into or out of FatBits mode. FatBits are a 4x blowup of 
the document, useful for detail work. To zoom in on a particular 
area, Apple-click the pencil on the spot you want to see. 

There are four ways to turn FatBits on and off: 

T Select FatBits from the Mise menu. 
T Press OF. 
T Double-click the pencil icon. 
T Apple-click the pencil on the spot you want to zoom in on. 

You can also get out of FatBits by clicking the pencil in the 
normal view area in the upper left of the window. 

All tools function normally in FatBits mode except for the eraser, 
which erases a smaller path than in normal viewing mode. 

Q.: When Dither Lock is on, FatBits enlarges each dithered 
pixel (similar to 320 mode FatBits). When it's off, each 
individual pixel is enlarged. You can toggle Dither Lock on 
and off while editing in FatBits. 

Toggles color cycling. See the example" Animation with Color 
Cycling" on page 26 and the Fill/Range dialog on page 74. 



Brushes... ti; 
(Apple-Semicolon) 

Lets you change the brush shape. Click on the desired brush 
shape and the dialog disappears. If you decide you don't want to 
change the brush shape, just click outside the dialog box. You 
can hold down the Option key to see what the custom brush 
looks like. You can also get this dialog by double-clicking the 
Brush tool. 

• • / "- :.:.: 

• • / " • • / '\. 

• • / " • • / " 
• , ... 

I Custom 

Brush Mirrors... til Lets you tum the brush mirrors on and off. Clicking on a line 
(Apple-Vertical Bar) toggles mirroring on that axis. Click in the center to toggle them 

all on or off. 

~ 

.. 

· . . . . . « Ok D 
(Cancel] 

When using the brush with mirrors turned on, each stroke is 
mirrored on the opposite side of the mirror line. (Remember 
those ink-blot tests from Kindergarten?) 
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Fill/Range... F Lets you set the fill method, ranges, cycling speed and direction. 
(Shift-F) You can also get this dialog by double-clicking the paint bucket 

or range icons. Each of the controls are described below. 

Normal 
Horizonta I Gradient 
Yertica I Gradient 
Radial Gradient 
Squi sh Brush 
Smooth Edges 
Change Edges 

Horizontal Gradient 

Fill/Range Settings 

Range: @ I 0 I I 
Mix :r:( ¢~IIi!II!II"""IIIIIII8IIIlIII!II!IIIII!r.¢~( 

S pee d :L( ¢x:..JUiIIIIIIiIi...lillllIllSllllllBL:¢::L.J( 

0111 OIV 

.':.' . ::.:.: .. :.: k( WffiWffiWffiWffiIlllllllllllIlllllllllll. 

Method:1 Radio I Gradient ~ 

Respect To:1 Object ~ 

(Sort](Clear](Cancel][ Ok D 

The Method pop-up menu lets you specify how you want the 
paint bucket to work. 

Normal 
Fills normally, using the current pen color or pattern. 

Horizontal Gradient 
Gradient fills from left to right, using the current range. 

Vertical Gradient 
Gradient fills from top to bottom, using the current range. 



Radial Gradient 

Radial Gradient 
Gradient fills from the center of the shape outward, using the 
current range. 

Squish Brush 
Squishes the current brush to fit the shape being filled. This fill 
method can be used with any of the built in brush shapes, but is 
most useful with a custom brush. 

Smooth Edges 
Smooths the inside edges of the filled shape. 

Change Edges 
Changes the inside edges of the filled shape to the current color 
or pattern. 
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Each Line 
Object 
Window 
Document 
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The Respect To: pop-up menu lets you specify gradient filling 
with respect to each horizontal line, the object, the window, or 
the whole document. 

Each Line 
The gradient will be adjusted to fit the length of each horizontal 
line being filled. If you gradient fill a circle, the gradient will 
look curved. Radial gradient fill is not affected by this option. 

Object 
The gradient is stretched to fit the size of the object. The gradient 
for every line is adjusted to fit the longest line in the object. 

Window 
The gradient for every line is adjusted to fit the size of the 
window. Only the colors in the range that would appear in the 
object if the whole window were filled are used. 

Document 
The gradient for every line is adjusted to fit the whole document. 
Only the colors in the range that would appear in the object if 
the whole document were filled are used. This can be useful for 
gradient-filling a sunset in several parts that aren't all visible in 
the same window space. 



The top color bar is the palette of all the colors. The bottom color 
bar is the range list for the current range. To add a color to the 
range, click on the palette (top) and the color is placed on the 
end of the range list. To rearrange the colors in the range, click 
on the color in the range palette and drag it where you want it 
inserted. If you drag it outside the range list and release the 
bu tton, the color is removed from the range. 

To make ranges work best with the other tools (the brush, 
airbrush and paint bucket), order the colors in the range from 
darkest to lightest, left to right, using the Sort button. 

Sort 
The Sort button sorts the colors in the range from darkest to 
lightest. Hold down the Option key when clicking Sort to sort 
from lightest to darkest. 

Clear 
The Clear button clears the current range. Hold down the 
Option key when clicking Clear to set the current range to all the 
colors in the palette. 

Mix 
The Mix scroll bar lets you change the amount of scattering used 
when gradient filling. Click on the left arrow for less scatter, or 
the right arrow for more scatter. 

I - II - III - IV 
The I, II, III, and IV radio buttons let you change the current 
range to be edited. 
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You can create animated effects using Platinum Paint's color 
cycling feature. Color cycling is a technique used to simulate 
animation. Cycling uses the ranges of colors you define in the 
Fill/Range dialog box. 

Color cycling is accomplished by changing the order of the 
colors in the palette colors according to the order of the colors in 
a range. A color in the palette takes on the color of its next 
neighbor (when cycling up) or previous neighbor (when cycling 
down) in the range. 

To see how this animation is done, open the file Radar on the 
Platinum Paint disk. Press a -Space Bar to go to full screen 
mode, then press the Tab key to turn the color cycling on and 
off. See the example" Animation with Color Cycling" on page 26 
for a description of how this animation was created. 

Speed 
The Speed scroll bar lets you change how fast the colors are 
cycled. The Tab key toggles color cycling so you can test the 
speed, range, and direction. 

Up/Down 
The Up radio button makes the colors cycle from low to high 
(forward, color 1-> color 16), and the Down radio button makes 
the colors cycle from high to low (backward, color 16 -> color 1). 

On 
The On check box lets you tum color cycling on or off for each 
range. This is useful for testing how colors cycle in one 
particular range without cycling all the ranges. For instance, to 
cycle just range II, check the On box for range II and uncheck it 
for ranges I, III and IV. 



Airbrush... ,,* 

Normal 
Mix 
Lighter 
Darker 
Random 
Brush 

Lets you change the way the airbrush works. The Speed scroll 
bar lets you specify how fast the airbrush should spray. The left 
side is the slowest, and the right side is the fastest. 

Airbrush Settings 

Method~ Normal k 
Speed: 

(Cancel) ¢ Ok D 

To change the nozzle size, hold down the Apple key and the 
mouse button, dragging the cursor down and to the right until 
the nozzle is the size you want. 

.
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This pop-up menu lets you specify the method the airbrush will 
use. 

Normal 
Normal spray paint using the current pen color or pattern. 

Mix 
Randomly mixes up the area under the nozzle. 

Lighter 
Sprays using the current range, from the first color in the range 
to the last color in the range. The longer an area is sprayed, the 
lighter it gets (assuming the range has been sorted from darkest 
to lightest). 

Darker 
Sprays using the current range, from the last color in the range 
to the first color in the range. The longer an area is sprayed, the 
darker it gets (assuming the range has been sorted from darkest 
to lightest). 

Random 
Sprays with a random color from the current range. 
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Curves... til 
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Brush 
Sprays with the current brush shape and method, in the current 
drawing mode. 

The Curve Settings dialog appears, letting you change the curve 
type and coarseness. 

3-point curve 

Curve Settings 
@ 3-point curve o Bezier curve 
D Closed 
Smoothness: 16 

(Cancel) [ Ok D 

This kind of curve has two end points and one control point. 

Bezier curve 
This type of curve has four control points and can be edited 
before it is drawn. 

Closed 
The Closed check box lets you specify whether the curve is 
closed off or not (by drawing a line back to the starting point). 

Smoothness 
The Smoothness scroll bar lets you specify how fine to draw the 
curve. The more points that are used to draw the curve, the finer 
the curve will look. 

~ Use a Smoothness of 2 points to draw triangles. 



Shadows... .@ A dialog appears which lets you specify the shadow offset and 
color. 

10 

(Cancel] 

In the center of the dialog is a sample of the current shadow 
settings. Moving the cursor inside the sample area changes the 
cursor to a light bulb. When you press the mouse button and the 
cursor is the light bulb, you can change the shadow offset as if 
light were shining from the light bulb. You can also use the 
scroll bars if you want to set an exact shadow offset. 

Clicking on the color box near the right side of the dialog brings 
up the familiar color menu, letting you select the shadow color 
or pattern. 
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Grid Size... eiG 
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A dialog appears, letting you change the grid size. 

Grid Size 

x:11I3 1 Y:I 8 

[Brush] [Se I ection ] 

(Cancel) ¢ Ok D 

The X number is the size of the grid horizontally, and the Y 
number is the size of the grid vertically. To type in a new grid 
size, click on the number you want to change and then type the 
number. 

The Brush button enters the size of the current brush shape. This 
is useful for tiling with a custom brush. To create a tiled 
background with the custom brush, click Brush and Ok, then 
tum the grid on using the Grid command on the Mise menu. As 
you drag the brush around the screen, the image stays aligned to 
grid points, creating a tiled pattern. Brushing with this technique 
is similar to brushing with a pattern, except the pattern can be 
any size you want. 

The Selection button enters the size of the current selection, also 
useful for tiling as described above. 



Show Page... .= Use this to get an idea of what the whole document looks like. A 
dialog appears, with a 50% reduction view of the whole 
document. 
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A box outline shows the portion of the document visible in the 
window. You can drag the box to change the current working 
area, then click Ok to return to normal viewing mode. 

You can also get this dialog by double-clicking the hand tool. 
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Palette... .E 
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Original 
Custom 
Brush 
Default 
Grafjscale 
EarthTone 
Rainbow 
Pastels 

Lets you change colors in the palette or use one of the built-in 
palettes. You can also get this dialog by Option-clicking the color 
selector in the tool window. 

Palette~ ~ E5191B: 0 

(Scale] 

(B I end] (Warmer] (Lighter] 

( Mix ] (Coo I er] ( Darker ] 

o Remap 
["C==-o-p-fj ..... ] (C a nee I] 

(Undo] « Ok D 

The top part of the window shows part of the document. 
Dragging the cursor inside that window moves the document, 
just like the hand tool. 

Holding down the Option key inside the window flashes the 
color under the cursor. Apple-clicking on a color makes that 
color the current color to be edited. 
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The easiest way to set up a palette is to start with one of the 
built-in palettes. Just click on the Palette pop-up menu and select 
a palette. Then you can use it as it is, or tweak it to suit your 
fancy. Platinum Paint's built-in palettes are described below. 

Original 
The palette the document was using when this dialog was 
opened. This command lets you revert to the document's 
original palette in case you edit it and mess it up. 



Custom 
The palette you've been editing since you opened this dialog. 
Use this if you switch to one of the built-in palettes, then want to 
go back to the original palette. 

Brush 
The custom brush's palette. 

Default 
The default system palette. This is the palette used when a new 
document is opened. 

Grayscale 
All grays, from black to white. 

EarthTone 
Some earthy colors. 

Rainbow 
Some bright colors from every part of the rainbow. 

Pastels 
A palette of light pinks, yellows, blues, etc. 

To select a color to edit, click on the color you want on the 
palette. Then you can use the scroll bars to adjust the color, or 
some of the buttons at the bottom of the dialog (described on 
page 87). 

Colors can be edited by two methods: Red-Green-Blue, or Hue­
Saturation-Value. The scroll bars are titled either R, G, and B or 
H, 5, and V. To change the color system used for editing colors, 
just click on one of these letters. 

85 



86 

UsingRGB 
Televisions and computer monitors make colors by combining 
varying amounts of red, green, and blue (RGB). Black is the 
absence of these colors; white is the equal presence of these 
primary colors. The RGB color system could be said to be the 
computer's "native" color system. 

The R, G, and B scroll bars control the amount of red, green, and 
blue in the color. For instance, using the R scroll bar, lower 
values mean less red, while higher values mean more red; zero 
means no red, while 15 is most red. The G and B scroll bars 
control the amount of green and blue in the color, respectively, 
and work just like the R scroll bar. 

Using HSV 
Another color system is the Hue, Saturation, and Value system 
(HSV), which breaks down colors into three parts. 

Hue is the first component. Think of the hue as being circular, 
starting at red (with a hue number of 0) and passing through 
yellow to green (84), through cyan to blue (168), through 
magenta and back to red. The hue number is just a position in 
the color spectrum. 

Saturation is the intensity or vividness of the hue. Higher 
saturation numbers result in more vivid colors; lower saturation 
numbers result in pale, pastel colors. A color with maximum 
saturation (255) is most pure; a color with minimum saturation 
(0) has the least amount of hue, resulting in a shade of gray. 

Value is the brightness or lightness of a color. Low value colors 
look dark, while high value colors look bright. 

The H, Sf and V scroll bars control the hue, saturation, and value 
components, and can range from 0 to 255. 



Sample Color Values 

Color Red Green Blue Hue Sat. Value 
black 0 0 0 0 0 0 
pure red 15 0 0 0 255 255 
pure green 0 15 0 84 255 255 
pure blue 0 0 15 168 255 255 
cyan 0 15 15 126 255 255 
magenta 15 0 15 215 255 255 
yellow 15 15 0 42 255 255 
brown 8 4 1 18 224 136 
teal 0 10 10 126 255 170 
peach 14 10 8 13 110 238 
pastel purple 13 12 15 181 51 255 
pastel yellow 15 15 9 42 102 255 
pastel green 11 15 12 94 68 255 
gold 15 12 5 24 171 255 
light gray 7 7 7 255 0 119 
white 15 15 15 255 0 255 

Grays are made up of equal amounts of red, green, and blue 

Undo OZ 
Undoes the last change made to the color being edited. 

Copy OC 
Duplicates a color. To use Copy, click Copy. On the color pa lette, 

lor 
rrst 

click on the color you want to copy, and then click on the co 
you want to copy to. The second color is replaced with the f 
color. 

Lighter OL 
d Makes the color lighter by adding one to each red, green, an 

blue component. 

Darker OD 
Makes the color darker by subtracting one from each red, gr een, 
and blue component. 
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Warmer 
Makes the color warmer by adding more red. 

Cooler 
Makes the color cooler by decreasing the amount of red. 

Blend OB 
A smooth blend from one color to another is made. The more 
colors in the blend range, the smoother the blend will look. 

To use Blend, click Blend, then click on the color to blend from, 
and then on the color to blend to. 

Mix 
Mixes two colors together by averaging their RGB or HSV 
values, depending which color system is in use. To use Mix, click 
Mix, then click on the first color to mix, then click on the second 
color. The current color becomes the average of the two colors 
mixed. 

Remap 
If the Remap option is on, the document is remapped to fit the 
new palette when you're done editing (when you click the Ok 
button). Otherwise, colors in the document are simply replaced 
with the new palette colors and no remapping is done. 

The scale button lets you pick colors from a scale of 256 colors 
displayed all at once. This is easier than trying to mix a new 
color; instead, you can just click on a color on the screen. There 
are 16 "pages" of 256 colors, each of which can be accessed with 
a scroll bar. 



The top part of the window shows a smooth scale of 256 colors. 
The color scale is three dimensional: the horizontal color 
component (red, green or blue) gets increasingly brighter from 
left to right; the vertical color component gets increasingly 
brighter from top to bottom; while the remaining color 
component (the additive) gets added evenly to all the colors on 
the screen. 

The additive scroll bar controls the amount of the additive color 
being added to the colors on the screen. For example, if the 
additive color is blue, clicking on the right arrow of the scroll bar 
increases the amount of blue being added to the screen. 

An inverse box on the color scale shows the position of the 
current color in the scale. 

To change the color being edited, click on a color in the palette. 

To select a color, simply click on the color you want. If you don't 
see a color you like, click repeatedly on the additive scroll bar 
until you find one you do like. 
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You can change the horizontal or vertical components by 
clicking on one of the R, G, or B buttons next to their respective 
titles. You can't change the additive (+:) color component; it is 
automatically set to the color component not used by Horz: and 
Ver:. For example, if Horz: is blue and Ver: is red, then +: must 
be green. Avoid setting Horz: and Ver: to the same color 
component, as this looks unsightly and is not very useful. 

Experiment with changing the color arrangement on the screen. 
Use blue for Horz: and red for Ver: for a screenful of hot colors, 
or blue and green for cool colors. 

When this option is off, a four color, non-dithered palette will be 
used. When this option is on, the palette is set up for dithering. 

It is not necessary to understand the following explanation of 
dithering to use Platinum Paint. However, an understanding of 
dithering will help you get the most out of 640 mode. 

Technically, the Apple IIGS is only able to display four "true" 
colors in 640 mode. That is, each 640 mode pixel can be one of 
only four colors. With a technique called "dithering," many 
more colors can be simulated. 

Dithering is a technique where two colors are placed closely 
enough to each other so that the eye sees them as one unit whose 
color is the average of the two adjacent colors. For instance, a 
black pixel next to a white pixel looks like one gray pixel; a blue 
and red pair looks like a purple pixel; yellow and red look like 
orange. Newspapers, magazines, and even this manual use a 
similar technique to show grays and colors. 



Platinum Paint implements dithering by treating each even-odd 
pair of pixels as one dithered pixel. Even and odd pixels have 
their own separate "rninipalettes" of four colors. Thus, a 
dithered pixel can be one of 16 colors, since even and odd pixels 
each have four possible colors (4 x 4 = 16). Notice that since it 
takes two pixels to make one dithered pixel, horizontal 
resolution is cut in half, to an effective resolution of 320 dithered 
pixels. 

In order to still be able to display 640 mode text, the default 
palette is set up so that any pixel can be black or white. The 
minipalette for even pixels is black, red, green, and white; for 
odd pixels it is black, blue, yellow, and white. Since both even 
and odd pixels can be black or white, we can still draw with the 
fine resolution of 640 pixels, as long as we draw in black or 
white. 

In summary, dithering combines two four color pixels to make 
one 16 color pixel. Resolution is 640 pixels wide if drawing in 
black or white, but only 320 pixels if drawing with a dithered 
color. 
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Sample Dithered Colors 

Even Odd Dithered 
black black black 
black blue dark blue 
black yellow gold 
black white gray 

red black dark red 
red blue violet 
red yellow orange 
red white pink 

green black dark green 
green blue blue-green 
green yellow yellow-green 
green white pastel green 

white black gray 
white blue pastel blue 
white yellow pastel yellow 
white white white 
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Patterns... .% 

Preferences ... 

Lets you change existing patterns or make your own. First, set 
the pen color to the pattern you want to edit, then choose the 
Patterns command. 

., .................. . . "'."'.", .... ",.", ... ...................... . ",.",.",."..",.",.", .... , ............... . .... "' ............. ... ...................... . "'."' .......... "' ... ...................... • "'.J' .......... J' ... .... , ............... . • J'."' ....... "'."'.'" ...................... 

Click on the palette to select a new drawing color. You can click 
on the FatBits area to draw in the current color. Click Ok when 
you're done editing the pattern, or click Cancel to leave the 
pattern the same. 

Lets you set some startup preferences. You can change the status 
of scroll bars, info bar, crosshairs, coordinates, centered objects, 
320 or 640 mode, etc. The new settings take effect the next time 
Platinum Paint is started, except for Space Windows and Screen 
Blank Delay, which take effect immediately. 

Startup Preferences 

o Di ther Lock o Draw from Center 
o Connect Brush 
o Spore Page 

@ 320 061.10 
181 Shadow 
181 FastPort 

Screen Blank De 1 a~: 

181 Scro 11 Bars 
181 Title Bar o Info Bar 
o Coordinates o Cross hairs 
181 Space Windows 

(Cancel] 

(H H: H H: S S) wi ~~:mru==----_...J118I On « Ok D 

When Space Windows is on, Clean Up or Stack Up leaves some 
space between windows. Tum it off to maximize screen space. 
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~ For maximum drawing space, turn off the Title Bar, Info Bar, 
Scroll Bars, and Space Windows. 

Dither Lock, Draw from Center, and Connect Brush let you set 
the default for these items on the Misc menu. Likewise, Scroll 
Bars, Title Bar, Info Bar, Coordinates, and Cross hairs let you set 
the defaults for each item on the Window menu. 

The Screen Blank Delay box lets you set how long Platinum 
Paint should wait before blanking the screen, to prevent screen 
''burn-in.'' When the mouse and keyboard are inactive for the set 
amount of time, the screen is blanked. Moving the mouse or 
pressing a key restores the screen. You can turn the screen 
blanker off by unchecking the On box next to the time. 

The Shadow check box lets you decide if you want to "shadow 
the screen" (a kind of buffering). Doing this increases all 
drawing speed from 8-20%, but costs you 32K of memory. It's 
your choice. 

When FastPort is on, some drawing operations will benefit from 
a 10-30% speed increase, especially noticeable with the curve 
tool. This is an option, and not always automatically used, 
because at the time of publication there was a problem in 
Apple's FastPort routine. (When pasting pictures from object­
oriented programs such as BeagleDraw, pattern changes aren't 
noticed, so the pasted picture looks monochrome.) 

Your preferences are stored in a file called Paint.Config on your 
Platinum Paint disk. 

If you launched Platinum Paint from an AppleShare server, the 
Paint.Config file is stored in your user folder on the server 
volume, instead of the folder Paint resides in. 



Title Bar T 

Inlo Bar I 

Scroll Bars S 

Coordinates # 

Crosshairs + 

320/640 Mode 

Window Menu 
Toggles the title bar on and off. 

Toggles the info bar on and off. Coordinates are displayed in the 
info bar, so turn it on when you want coordinates. 

Toggles the scroll bars on and off. 

Toggles coordinates on and off. The info bar must be on to see 
the coordinates. 

Toggles the crosshairs on and off. The crosshairs are great for 
aligning one object with another on the screen. Turn them on 
when you need to put the cursor right on the horizontal or 
vertical edge of an object. 

Switches to the other screen mode. The picture's original palette 
and patterns are kept until either one is edited. When the picture 
is saved, however, it is saved in the current mode with the 
current colors. 

For instance, if you created a 320 mode picture and then 
switched to 640 mode, Platinum Paint still remembers the 
original 320 mode palette and patterns. But as soon as you edit 
the palette in 640 mode, or save the picture, the picture becomes 
a 640 mode picture and the 320 palette is gone. The patterns are 
still intact, but since they are 320 mode patterns they won't look 
right in 640 mode. 

[b): You can have Platinum Paint start up in the other screen 
mode by holding down the Option key as the program 
loads. 
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Hide Document 

Hide Tools tiH 

Full Screen 
(Apple-Space Bar) 

Clean Up tiK 

Stacie Up 

All open windows 
(Gl, 02, d3 or 04) 
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Hides the current document. Use this to unclutter the desktop, 
for example, if you want more screen space to use a desk 
accessory. The window is still alive; to redisplay it, choose it by 
name from the list at the bottom of the Window menu. 

Hides the tool window, freeing up more screen space. 

Press a-Space Bar to zoom into full screen mode. To zoom back, 
press a-Space Bar again, or press aK to clean up. Holding down 
the Option key while selecting Full Screen leaves the menu bar 
on the screen. 

Cleans up the screen by moving the tool window to its usual 
position and tiling all open Paint windows. You can use this to 
get out of full screen mode, or just when things get too cluttered. 

[b): Option-Clean Up leaves no margin between windows. This 
is like temporarily turning Space Windows off. See the 
Preferences dialog on page 93 for a description of the Space 
Windows option. 

Cleans up the screen by moving the tool window to its usual 
position and stacking all open Paint windows. You can use this 
to get out of full screen mode, or just when things get too 
cluttered. 

This is a list of all open windows. Choosing one of these items 
makes that document the current document. 



Normal 1 

Matte 2 

Mode Menu 
The Mode menu lets you change the way the brush works. The 
best way to understand these modes is to experiment. 

The first nine commands, those that control the brush method, are 
accessible by using the numeric keys on the main part of the 
keyboard. The second group of commands, those that control 
the drawing mode are accessible by using the keys on the numeric 
keypad to the right of the main keyboard. 

U: To make the shape and text tools use the selected 
drawing mode (instead of Copy), hold down the Apple 
key when you begin drawing. 

~ The drawing mode only affects the brush when using the 
Normal, Matte, Smear, Slide and Cycle methods. 

:
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This is the normal brush method. This method uses the brush's 
shape but not its coloring; instead, the current pen color or 
pattern is used. 

Matte method uses the brush's image and shape as it was 
originally created. Use this method when you're painting with a 
custom brush. 
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Smear 3 

Slide 4 

Charcoal 5 
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Smears the area under the brush. This is like running your brush 
across wet paint. The smear on the right side of this curve was 
done with a round brush, Smear method, and Copy mode. The 
smear on the left was done with Blend mode instead of Copy. 

Use Smear with Connect Brush turned off. This makes smearing 
look more natural. 

~ Try using Smear with Blend mode turned on. This smooths 
the effects of the smear, giving subtle shading and a more 
natural, less computerish look, as shown on the left of this 
curve. 

Slide uses the area under the brush when the mouse is first 
clicked as the brush's image. This has the effect of dabbing your 
brush on wet paint and smearing it all over the paper, except the 
paint on your brush never rubs off (at least not until you let go 
of the mouse button). It works similar to the Pickup command, 
except it only lasts until the button is released. In this example, a 
round brush is slid across the edge of the curve. 

Charcoal makes the area under the brush darker every time you 
pass over an area. The more times you brush over an area, the 
darker it gets. It works by shifting all the colors in the current 
range down one. Colors under the brush that are not in the 
current range are not affected. If there are no colors in the 
current range, all colors will be shifted. Charcoal requires the 
range to be ordered from darkest to lightest. To get a true 
charcoal effect, make a range with several different shades of 
gray. For best results, use Charcoal with Connect Brush turned 
off. 

1[;]: Holding down the Option key when you start brushing 
uses white "charcoal", making the area lighter instead of 
darker. Normal charcoal is shown on the right, white 
charcoal on the left. 



Shade 6 

Wash 7 

Smooth 8 

Cvcle 9 

Shade takes the hue of the color under the brush and gives it the 
shade, or brightness, of the pen color. For instance, painting over 
dark green with a light blue pen color results in a light green. 
Shade works best when the palette has at least two ranges of 
colors with similar hue and brightness values. 

Wash takes the shade, or brightness, of the color under the brush 
and gives it the hue of the pen color. For instance, painting over 
dark gray with a bright red pen color results in dark red. This is 
excellent for colorizing grayscale or scanned images. Wash 
works best when the palette has at least two ranges of colors 
with similar hue and brightness values. See the example 
"Colorizing Grayscale Images" on page 24 for a demonstration. 

Smooths the edges of the area under the brush. Smooth has the 
effect of blurring the picture. It's excellent for smoothing out 
high-contrast areas, or creating more subtle, lifelike shading. 

For best results, use Smooth with Connect Brush off. 

Draws the brush in each of the colors in the current range. This 
is different from Color Cycling in the Misc menu. Each time you 
move the brush, a different color from the range is laid down. 

99 



Copy 0 
(Keypad 0) 

(Keypad 1) 

XOR 2 
(Keypad 2) 

BIC 3 
(Keypad 3) 

100 

It is only necessary to understand two important drawing 
modes, Copy and Blend. It is not necessary to understand the 
other three drawing modes to use Platinum Paint effectively. 
Useful applications of some of these modes may not be obvious. 
These options are provided because the Apple IIGS QuickDraw 
routines provide them. The best way to understand these modes 
is to experiment. 

The drawing mode affects the way the paint is put on the 
document. Paint can be laid over or combined with other paint. 
The drawing mode is used by all the tools except the paint 
bucket, airbrush, pencil, and eraser. 

Copy mode is the normal way of painting; it "copies" new paint 
right over the top of old paint without mixing it. 

The OR mode overlays the source image (or pen color) on black 
portions of the document, but not on white areas. Results are 
unpredictable when drawing over colored areas. 

The XOR mode inverts the document where white is being 
painted. Using XOR mode with a pen color other than white 
produces unpredictable results. 

BIC mode turns off (colors black) pixels in the document that 
match the pen color. Painting over red pixels with a red pen 
color changes them to black. 



Blend 4 
(Keypad 4) 

Blend mode mixes the new paint with the old paint. For 
instance, if painting black paint on top of white paint, gray paint 
will be put down; painting blue paint over red paint results in 
purple paint being put down. Blend mode is only available to 
the brush, lasso, and marquee. 

Use this mode especially with Smear to soften edges. 
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Maslc 

Only Area 

Add Area 

Remove Area 
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Mask Menu 

Masks are a powerful tool that"allow you to protect certain parts 
of your document from being changed. Nothing will draw over 
masked areas, even the eraser. You can mask off both areas and 
specific colors, and the mask is saved with your document. 
(Each document you create has its own mask.) 

Normally, a document doesn't have a mask when you first 
create it. A mask is created for your document when you select 
an area or color to add to the mask. Note that a mask requires 
about 62K, so if you're low on memory, you may not be able to 
use masks. 

When you mask a color, all areas in the document containing that 
color are added to the mask, not the color itself. If you paint a 
pink blob, add pink to the mask, then paint another pink blob, 
the second blob isn't masked just because it is pink-only the 
area containing the first blob is masked. 

Toggles the mask on and off. Use this command when you need 
(Accent) to unmask an area so you can work on it, then mask it again so it 

won't be disturbed. 

Masks only the area selected, regardless of the previous mask. 
This is like clearing the old mask, then adding a new area. 

Adds the selected area to the mask. 

Removes the selected area from the mask. 



Onlv Color 

Add Color 

Remove Color 

Masks only the color selected, regardless of the previous mask. 
This is like creating a brand new mask, and adding one color to 
it. 

To use Only Color, select it from the Mask menu. The cursor 
changes to the color picker cursor. Click on the color you want to 
mask, and it's added to the mask. You won't be able to modify 
any part of the document that uses the color you selected. 

Adds the color selected to the mask. The cursor changes to the 
color picker; just click on the color you want to add. Use this if 
the document already has a mask and you want to add another 
color to it. 

Removes the color selected from the mask. Click on the color 
you want to remove with the color picker, and the areas 
containing that color are unmasked. Don't confuse this 
command with the Remove Color command on the Edit menu, 
which lets you remove a color from a selection. 
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Maslc Colors... ,,' A dialog appears at the bottom of the screen, letting you choose 
(Apple-Accent) which colors to mask. 

Invert Maslc .. 
(Tilde) 

Flash Maslc 

1014 

(Cancel] 

@ Hew 0 Add 0 Remove ( Clear ][ Ok D 

Clicking on the palette selects colors to mask. You can also click 
on colors outside the window. A square dot on a color indicates 
it's selected. 

The Clear button clears the current selection of colors. Holding 
down the Option key when clicking Clear selects all colors. 

The New button makes a new mask-it works similar to the 
Only Color command, except you can select more than one color 
to add to a new mask. 

The Add button adds the selected colors to the mask already in 
use. 

The Remove button removes the selected colors from the mask. 

Inverts the mask so that previously masked areas are unmasked, 
and vice versa. As an example, let's use a scene with a house in 
the foreground and mountains and clouds in the background. To 
work on the mountains without changing the house, mask off 
the house by selecting it and choosing Only Area from the Mask 
menu. Then, when you want to work on the house again, 
without affecting the mountains, just select Invert Mask. The 
area containing the house will be unmasked, and everything else 
will become masked. 

Flashes the masked areas. Use this to see what areas and colors 
are masked. 



Free Masl( 

Get Spare/Kill Spare 

Gets rid of the mask, freeing up about 62K of memory. 
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The spare page is like a document, except it doesn't have its own 
window. You can instantly switch from the document to the 
spare page to do some experimentation, and then switch back 
when you're done. It's like turning the document over and using 
the back side for a scratch pad. 

The spare page does have one drawback: it requires about 62K 
of memory, so if you're running low, get rid of it by selecting 
Kill Spare. 

Some suggested uses for the spare page: 

'Y For rough drafts. Use the spare page for experimentation, to 
get that perfect touch, then copy it to the document. 

'Y For an in-memory backup of your picture. Don't use this 
instead of saving, but with saving. For instance, if you want 
to test some major changes, first select "Doc to Spare", and 
if your changes don't come out right, just undo the damage 
by selecting "Spare to Doc". 

Tip: If you're done working in the spare page and want to move 
your image back to the document, you can select it with the 
marquee or lasso, then use Spare Page to switch back. You can 
then place the selection anywhere in your document, because it 
stays "floating" over the document when you switch to and 
from the spare page. You don't need to copy it to the clipboard 
and then paste it in. 

Use this to get the spare page or to kill it if you already have one. 
This is useful if you run low on memory, since killing the spare 
page frees up about 62K of memory. 

You can set Platinum Paint to automatically get a spare page 
when it starts up by checking the Spare Page box in the 
Preferences ... dialog box, described on page 93. 
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Spare Page _ 1\ Use this to switch between the spare page and the document. 
(Apple-Caret) When you're working on the spare page, an 5 is shown in the 

info bar. 

Doc to Spare _> 

Spare to Doc _< 
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Use this to copy the document to the spare page. The spare 
page's previous contents are replaced. 

Use this to copy the spare page to the document. The 
document's previous contents are replaced. 



Attributes... etA 

BaCI(groumJ 

Font Menu 
Use this to choose a certain font, size and style. This is useful if 
you need a certain size that's not in the Size menu, or if you 
want to change a font's attributes all at once. 

onaco 
Hew York 
San Francisco 

St~ I e: 

o Plain t:¥ Ifr{}-I 181 Bold 
o Italic 
D Underline 
o Outline 
o Shadow 

Size: 
I f;'1 

(Cancel] 

[ OK D 

The Font list box shows all of the fonts installed on your startup 
disk. 

The Style check boxes let you apply any combination of the 
styles available on the Style menu. 

The Size list box displays all of the available sizes. You can type 
a different size that doesn't appear in the list and the font will be 
scaled to the new size. 

When this is off, the text you type has no background. When this 
is on, a background is cleared underneath the text. This is useful 
for typing text over a cluttered area. 

The rest of the Font menu lists any fonts installed. 
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Plain tiT 

BOld tlB 

Italic til 

Underline tlU 

Oulline 

Shadow 

Align Left tiL 

Align Middle tiM 

Align Righi tlR 
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Style Menu 
Types just plain text without any style. 

Boldface text. 

Italicized text. 

Underlined text. · 

O1Ul1tlliume text. 

Slhl~dow text. 

Use this to left justify the text. 

Use this to center some text. This is useful for labelling an object. 
Click where you want the center of the label to be and type the 
label. 

Use this to right justify the text. It's useful for labelling the left 
side of an object. Click where you want the right edge to be and 
type. 



8, 10, 12 ... 72 or ?? 

Size Menu 
The Size and Style menus aren't available in 320 mode, since 
there isn't enough room for them on the menu bar. Use the 
Attributes dialog to set the size and style of text when painting 
in 320 mode. 

Selects the size of the current font. The last size is the weird size, 
which can be set by using the Attributes command on the Font 
menu. 
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Key Command 
Relerence 
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• Airbrush L M 
Dropper H A 
Brush F 
Pencil ~ 

E Eraser I / B E 
H Hand 

B []II CD R F Fill 
L Lasso 0 CD "1b. U 

M Marquee Q ~ c.r. P 

I Line 
A Text 

~Q Solid Freehand q Freehand 
~O Solid Oval 0 Oval 
M' Solid Polygon p Polygon 
~ Solid Round Box r Round Box 
~B Solid Box b Box 
~U Solid Curve u Curve 

While Drawing: 

Escape Toggle the cursor on and off 
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Return Toggle mouse button up and down 
Arrows Move the cursor one pixel 

Selection & Brush Commands 

~D Double d Halve 
N Invert @ Cast Shadow 
X Flip Horizontal y Flip Vertical 
~I Slant ~S Stretch 
a, Brushify ax Cut 
K Collapse aCCopy 
< Remove Color aVPaste 
> Replace Color az Undo 

Option-~S 

ClearlDelete 
Control-A 
Control-C 

Resize by percentage 
Clear 
Again (Repeat last command) 
Center selection 

Next Brush 
Previous Brush 

= Next Line Width 
Previous Line Width 

] Next Color 
[ Previous Color 

Brush Methods & Drawing Modes 

1 
2 
3 
4 
5 
6 
7 
8 
9 

aA 

aT 
aB 
al 
au 

a{ 
a} 

Normal 10 Copy 
Matte 11 OR 
Smear 12 XOR 
Slide 
Charcoal 13 BIC 

Shade 14 Blend 
Wash 
Smooth 
Cycle 

Font, St,le & Size Commands 

Attributes ... 

Plain 
Bold 
Italics 
Underline 

Previous Font Size 
Next Font Size 

Legend 

Apple key 
Shift key 

aL 
aM 
aR 

Numeric keypad key 

Align Left 
Align Middle 
Align Right 



O N New 
0 0 Open 
OP Print 
O Q Quit 
OS Save 
OW Close 

Window Controls 

0 1 Window 1 
0 2 Window 2 
0 3 Window 3 
0 4 Window 4 

OH Show/Hide Tools 
OK Clean Up Windows 
0 = Show Page ... 

OF FatBits 
O-Space Bar Full Screen 

T Title Bar 
I Info Bar 
S Scroll Bars 
# Coordinates 
+ Crosshairs 
O-Escape Menu Bar 

Masking & The Spare Page 

0 ' Mask Colors ... 
Invert Mask 
Mask On/Off 

OA Spare Page 
0 > Doc To Spare 
0 < Spare To Doc 

Tab Cycle Colors 
OD Dither Lock 
C Connected Brushes 
O G Grid Size ... g Grid On/Off 

Palelle, Range & Effect Dialogs 

0 ; Brushes ... 
o I Brush Mirrors ... 
0 · Airbrush ... 
0 ) Curves ... 
O@ Shadows ... 
OE Palette .. . 
0 % Pa ttems .. . 
N Fill/Range ... 
O-Control-@ About Platinum Paint... 
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Help! 
Technical Supporllnlormalion 
If you have questions or problems that your dealer can't answer, 
you can contact the Beagle Bros Technical Support Staff for 
expert assistance. 

Before calling, check the instruction manual to see if it contains 
the information you need. Write down a complete description of 
the problem, the version number of the software, and the names 
and version numbers of any other programs you're using in 
connection with our software. 

If you have a modem, you may also receive Technical Support 
on our 24-hour Bulletin Board, Pro-Beagle. The system provides 
an electronic mail and conferencing system, along with the latest 
information about product updates and changes. 

Technical Support: 
(619) 452-5502 8 am to 5 pm, weekdays (Pacific time) 

Pro-Beagle Bulletin Board: 
(619) 558-6151 24 hours, every day 

FAX: 
(619) 452-6374 24 hours, every day 

Or, you can write to: 
Beagle Bros, Inc. 
6215 Ferris Square, Suite 100 
San Diego, CA 92121 
Attn: Technical Support 

115 



116 



320 / 640 Mode 95 Brush shapes 73 
50% reduction view 83 Brushify 18,40,65 
640 mode 71,90 Built-in palettes 84 

A C 
Add Area 102 Cast shadow 70 

Add Color 103 CDevs 52 

Additive 89 Cen ter shapes 43, 71 

Again 24,62 Center selection 112 

Airbrush tool 37 Change edges 75 

Airbrush settings 79 Charcoal 98 

Align Left 108 Chroma 20,61 

Align Middle 108 Circular 43 

Align Right 108 Clean up 96 

Alignment 35, 108 Clear 34,64 

Alphabet 53 Clipboard 40,61,62 

Alternate character set 53 Close 55 

Animate command 59 Close box 12 

Animation 27 Close bu tton 55 

Apple menu 51 Closed 80 

Apple Preferred 56 Cloud 23 

A ppleShare 94 Collapse 70 

Arrow keys 30 Color cycling 27 

Attributes 35, 107 Color remapping 63 
Color ribbon 61 

B Color selector 47 

Background 34, 107 
Colorizing 24, 66 
Command 6 

Background color 42, 47 Complex selection 32 
Backup 4 Connect brush 71 
Beagle Bros, Inc. 115 Constrains 15,31 
Best mode 61 Control Panel 52 
Bezier curve 44, 80 
BIC 100 

Control points 44 
Cooler 88 

Blend 23,88, 101 
Bold 108 

Coordinates 30,50,95 

Border color 15,47 
Copy 

color 87 
Box 43 
Brush tool 38,39,40 

drawing mode 100 

Brush method 23,97 
palette 64 

Brush mirrors 73 
to clipboard 62 

Brush palette 64 
Crosshairs 3D, 95 
Curve tool 44 
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Curve settings 80 FastPort 94 
Custom brush 18,40,65,73 FatBits 41,72 
Cut 62 FAX 115 
Cycle mode 99 File menu 54 
Cycle colors 72 Fill tool 36 

Fill/Range 16,74 

0 Fix aspect ratio 57 

Darken 65 Flash 47 
Flash mask 104 Darker 79, 87 
Flip Horiz 19,67 DC Printer 52 

Default 85 Flip Vert 67 

Degree 69 Folder 54 

Delete 34,64 Font 5,107 

Delta coordinates 50 Free mask 105 

Desktop 11 Freehand lines 41 

Dither lock 6,33,50,71 Freehand shape 45 

Dithering 6, 90 Full screen 96 

Do It 64 
G Do Nothing 64 

Doc to Spare 106 Get spare 105 
Document 5,76 Grayscale 24, 66, 85 
Document window 11 Grid 71 
Double 19,67 Grid size 82 
Double HiRes 58 GS/OS 3 
Down 78 
Draw from center 43 H 
Drawing modes 100 

Halve 19,67 Dropper 46 
Hand 17,34,41 

E Handles 18 
Help 115 

Each line 76 Hide document 96 
EarthTone 85 Hide tools 96 
Editmenu 62 HiRes 58 
Editing colors 85 Horizontal gradient 37,74 
Enter 35 HSV 86 
Erase window 42 Hue 86 
Eraser 42 
Escape 30 I 
F ImageWriter Emulator 53 

Import 57 
Fast mode 61 Info bar 13,50,95 
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Invert 65 
Invert mask 104 
Irregular shape 45 
Italic 108 

K 
Key Command Reference 111 
Key translation 7 
Keyboard commands 6,13,112-113 
Kill spare 105 

L 
LaserWriter 53 
Lasso 18,32 
Light bulb 81 
Lighten 65 
Lighter 79,87 
Line 15,42 
Line height 48 
Line size selector 48 
Line width 48 
Load brush 57 
Lunch 13 

M 
MacPaint 57 
Marquee 31 
Mask 6,102 
Mask Colors 104 
Mask menu 102 
Matte 97 
Memory 3,51 
Method menu 74, 79 
Mirror Horiz 67 
Mirror Vert 67 
Mirrors 73 
Mise menu 71 
Mist 37 
Mix 17,77,79,88 
Mode menu 97 
Modifier keys 6,31 

N 
Negative 65 
Network 53 
New 54 
New Folder button 56 
No vertical gaps 59 
Non-dithered palette 90 
Nozzle size 37,79 

o 
Object 76 
Only Area 102 
Only Color 103 
Open 54 
Option key 13 
Option key translation 53 
OR 100 
Outline 108 
Oval 15,43 

p 
Page Setup 59 
Paint brush 38 
Paint bucket 15,36 
Paint.Config 94 
Paintworks animation 59 
Palette 5,84 
Paste 62 
Pastels 85 
Patterns 47, 93 
Pen color 14,47 
Pencil 41 
Perspective 69 
Pickup 70 
PixelS 
Plain 108 
Polygon 45 
Pop-up color menu 14 . 
Preferences 93 
Print 20,60 
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Print Shop 58 
Printer driver 52 
Pro-Beagle 115 
Program Disk 10 
Pull-down menus 13 

Q 
Quit 61 

R 
Radar 27 
Radial gradient 75 
Rainbow 85 
RAM3 
Random 79 
Range 5,27,33,37,77,98,99 
Range list 77 
Range selector 17,49 
Reduction 59 . 
Remap 88 
Remap Brush 65 
Remap Doc 65 
Remap document 64 
Remap selection 64 
Remapping 63 
Remove Area 102 
Remove Color 

from selection 66 
from mask 103 

Replace Color 66 
Resize 68 
Respect To menu 76 
Return key 30 
Revert 56 
RGB 86 
Rotate 69 
Rounded box 43 

s 
Sample color values 87 
Saturation 86 

Save 55 
Save As 20,55 
Save brush 57 
Scale 88 
Scanned images 66 
Scatter 17 
Screen blank delay 93 
Screen mode 95 
Scroll bars 12, 95 
Selection button 82 
Selection 5 
Shade 66,99 
Shadow 81, 94, 108 
Shadow color 81 
Shadow offset 81 
Shapes 43 
Show page 83 
SHR 56 
Shrink to fit 32, 70 
Size 107 
Size box 13 
Size menu 109 
Slant 68 
Slide 98 
Smear 23,98 
Smooth 23,66,99 
Smooth edges 75 
Smoothness 80 
Sort 77 
Space windows 93 
Spare page 105, 106 
Spare to Doc 106 
Speed 27,78,79 
Spray 37 
Square 43 
Squish Brush 22,36-37,75 
Stack up 96 
Standard mode 61 
Stretch 18,33,68 
Style 107 
Super Hi-Res screen file 56 
System Disk 10 



T 
Tab key 78 
Technical Support 115 
Text 34 
Text Only mode 61 
Tiling 82 
Title 12 
Title Bar 11,95 
Tool window 30 
Translation 53 
Tutorial 14 
Typeface 5 

U 
Underline 108 
Undo 62 
Up 78 
Use dithering 90 
Use HiRes palette 58 
Use selection's palette 64 
User name 53 

V 
Value 86 
Version number 51 
Vertical condense 59 
Vertical gradient 16,37,74 
Volumes 54 

w 
Warmer 88 
Wash 24,66,99 
Window 76 
Window menu 95 

X 
XOR 100 

Z 
Zone 53 
Zoom 41 
Zoom box 12 

121 



122 



123 



124 



BEAGLE BROS, INC. 
6215 Ferris Square, Suite ]00 · San Diego, CA 92]21 

Office (619) 452-5500 · FAX (6]9) 452-6374 




